Introduccion

Este libro surge con el propésito de acercar al lector a los aspectos mas importantes en el desarrollo de aplicaciones
para dispositivos méviles y en particular, a las caracteristicas de nuevos entornos y lenguajes que le permitiran
adquirir facilmente experiencia en este campo. Con tal propésito, este libro puede servir de apoyo para estudiantes
de los Ciclos Formativos de Grado Superior de Desarrollo de Aplicaciones y de las Ingenierias Técnicas y
Superiores.

La alianza entre grandes companias que apuestan por las tecnologias méviles ha favorecido la creaciéon de
plataformas para el soporte de aplicaciones desarrolladas para contextos como el entretenimiento, la educacion, el
turismo, entre otros, adaptandose al vertiginoso cambio tecnolégico que vivimos en la actualidad y que exigen por
tanto, adquirir los conocimientos y destrezas necesarios mas demandados hoy en dia en el mercado laboral.

Para todo aquel que use este libro en el entorno de la ensefianza (ciclos formativos o universidad), se ofrecen varias
posibilidades: utilizar los conocimientos aqui expuestos para inculcar aspectos genéricos del desarrollo de aplicaciones
para dispositivos méviles o simplemente centrarse en preparar a fondo alguno de ellos. La extension de los contenidos
aqui incluidos hace imposible su desarrollo completo en la mayoria de los casos.

Ra-Ma pone a disposicién de los profesores una pagina web para el desarrollo del tema que incluye las soluciones
a los ejercicios expuestos en el texto, un glosario, bibliografia y diversos recursos para suplementar el aprendizaje
de los conocimientos de este médulo. Puede solicitar el medio de acceso a dichos recursos a editorial@ra-ma.com,
acreditandose como docente y siempre que el libro sea utilizado como texto base para impartir las clases.
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DISPOSITIVOS MOVILES: TIPOS, HISTORIA Y EVOLUCION

La revolucion de los dispositivos para comunicaciones mdéviles tiene tan solo 20 afios. Durante este tiempo la
tecnologia ha evolucionado desde la voz a la informacién inalambrica y el uso de dispositivos méviles se ha convertido
en algo cotidiano. Gracias a ello, en la actualidad tenemos la posibilidad de comunicarnos con cualquier persona, en
cualquier momento y desde casi cualquier lugar.

La primera semilla para este gran desarrollo fue plantada por el célebre matemaético escocés James Clerk
Maxwell, quien formulé, en el ano 1860, un par de ecuaciones cuya soluciéon predijo la propagacion de las ondas
electromagnéticas a la velocidad de la luz. Se necesitaron 20 afios para comprobar dicha prediccién en un laboratorio
y otros 20 afios mas para que se llevara a cabo la primera aplicacién mévil.

Existen diversos tipos de dispositivos méviles, como los que se muestran en la Figura 1.1.
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Figura 1.1. Tipos de dispositivos méviles

Desde los enormes terminales méviles a los teléfonos inteligentes, los teléfonos han recorrido un largo camino, en
relativamente no demasiado tiempo. Durante ese recorrido, las tecnologias han ido mejorando para ofrecer al usuario
una amplia gama de prestaciones. Asi, hemos pasado de dispositivos con grandes dimensiones, costosos y con baterias
que duraban alrededor de 60 minutos, a dispositivos con precios al alcance de los usuarios, con baterias que duran
entre 4 y 10 horas y con cada vez mejores prestaciones como el acceso de alta velocidad a Internet.

Y gracias a estos avances, podemos hablar del concepto de Computacién Ubicua, formulado por Mark Weiser
en 1991, quien la definia como completamente opuesta a la realidad virtual, la cual pone a las personas dentro del
ordenador para generar mundos, mientras que la computacién ubicua pone al ordenador dentro del mundo de las
personas.

La computaciéon ubicua se fundamenta en cuatro paradigmas: (i) descentralizacion, (ii) diversificacion, (iii)
conectividad y (iv) simplicidad.

La descentralizacion se caracteriza por el paso de la era mainframe en la que la potencia estaba centralizada,
a la era PC, en la que se define la arquitectura cliente-servidor. A partir de este paradigma se empez6 a hablar de la
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sincronizaciéon como un aspecto fundamental para mantener los datos actualizados. La descentralizacion benefici6 a
los proveedores, pues les dio mas flexibilidad para proporcionar servicios.

Por su parte, la diversificacion surgié de la necesidad de ofrecer el mismo servicio, pero adaptado a diferentes
dispositivos, ya que hasta el momento se habian desarrollado herramientas especializadas para dispositivos con
funcionalidades especificas, dependientes del entorno y del grupo de usuarios. Asi pues, la diversificacién permitié
tener la misma funcion desde varios dispositivos.

El desarrollo de dispositivos trajo consigo un problema, la integracion entre plataformas. Por lo tanto fue necesaria
la definicién de estdandares y protocolos que permitieran una conectividad sin limites, en la que cualquier tipo de
software se pudiera ejecutar sobre cualquier plataforma y red. Este fue el punto de partida para el desarrollo de
importantes estdandares como WAP (Wireless Access Protocol, Protocolo de Acceso Inalambrico), UMTS (Universal
Mobile Telecommunications System, Sistema Universal de Comunicaciones Méviles) o BlueTooth (protocolo de
comunicacién para redes inaldmbricas mediante radiofrecuencia).

El ultimo paradigma de la computacion ubicua es la simplicidad, centrada en el diseiio de dispositivos con
interfaces de usuario intuitivas. Apuesta ademas por la integracion entre el software y el hardware para lograr mejor
cobertura de las necesidades del usuario final, proporcionando ademaés un acceso a los datos rapido y de forma sencilla.

Asi pues, con la evolucion de los dispositivos méviles las tendencias son: que la computacién ubicua pueda
ofrecer conectividad en tiempo real 24/7, que los precios de los dispositivos y de los planes de datos ofrecidos por las
operadoras de telecomunicaciones bajen, que la infraestructura de las redes mejore, que se pueda tener acceso a todo
desde cualquier parte de la nube y que se dé una gran explosion en el desarrollo de aplicaciones para dispositivos
moviles.

A continuacién, las Figuras 1.2, 1.3 y 1.4 resumen la historia y evolucién de los dispositivos méviles entre los afios
1973 y 2011.
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Figura 1.2. Evolucién de los dispositivos méviles (1)
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CARACTERISTICAS Y LIMITACIONES EN EL DESARROLLO DE
APLICACIONES PARA DISPOSITIVOS MOVILES

Las aplicaciones moéviles no son aplicaciones de escritorio adaptadas para dispositivos con pantallas pequenas,
son por el contrario, aplicaciones diferentes por varias razones: (i) la capacidad para comunicarse desde cualquier
lugar cambia la interaccién del usuario con la aplicacién, (ii) la interfaz de usuario para una pantalla y teclados
pequerios difiere de forma significativa de la interfaz de una aplicacién diseiiada para un ordenador de sobremesa o
un portatil, (ii) los tipos de canales de comunicacién son diferentes, los dispositivos méviles incorporan capacidades
de voz, mensajeria, informacién de geolocalizacion y video conferencia (en algunos teléfonos). Las mejores aplicaciones
para méviles integran estas capacidades para optimizar la interaccién del usuario con los datos y, por dltimo, (iv) la
naturaleza de las redes inalambricas, aunque las redes ofrecen capacidades de datos de banda ancha, estas pueden
variar, dependiendo de la calidad de la sefial y de la disponibilidad de conexién de la red, en particular si se trata de
usuarios méviles.

LIMITACIONES EN LA EJECUCION DE APLICACIONES PARA DISPOSITIVOS MOVILES

El desarrollo de aplicaciones para dispositivos méviles requiere tener en cuenta las limitaciones que podemos
encontrar a la hora de ejecutarlas. Estas limitaciones estan relacionadas, principalmente, con las caracteristicas
hardware y de conexién, asociadas a cada dispositivo mévil.

A pesar de que la capacidad de procesamiento y la memoria de los dispositivos méviles han ido mejorando con el
paso del tiempo, las aplicaciones deben disenarse evitando la sobrecarga de elementos multimedia, que exijan del
dispositivo ciclos de procesamiento demasiado largos.

El tamafio de las pantallas y la iluminacion también son factores determinantes en el disefio de aplicaciones.
No hay que olvidar que la mayoria de los datos de entrada que proporciona el usuario son introducidos con una sola
mano y en muchas ocasiones en movimiento. Por lo tanto, en la medida de lo posible se le debe facilitar al usuario la
entrada de datos por pantalla, a través de los botones de navegacién propios de cada dispositivo, de modo que pueda
ir seleccionando opciones (desde un ment desplegable, por ejemplo), y que no tenga que rellenar campos de texto, de
esta forma podra realizar varias operaciones en poco tiempo.

La distribucién de los elementos en la interfaz marca la diferencia, no solo en la forma en la que se presenta la
informacidn, sino también en cémo navega el usuario a través de ella. Lo fundamental es ofrecer interfaces a través
de las cuales la entrada de los datos se realice de la forma mas intuitiva y natural. Una buena opcién es agrupar la
informacién por funcionalidades o por jerarquias, de modo que el usuario acceda a la informacion que necesita en cada
momento, sin tener que pasar por pantallas o informacién irrelevante para el tipo de operacién que desea realizar.

Si ademds tenemos en cuenta que cada vez que accedemos desde nuestro teléfono mévil a Internet estamos
pagando una tarifa por cantidad de bytes descargados y no por tiempo de uso de la red de datos, es necesario que el
envio y la recepcion de datos se realicen dentro de un tiempo de espera aceptable. Durante el proceso de envio y/o
recepcion de datos, debemos mantener informado al usuario sobre el progreso de esta operacion y el tiempo estimado
para la finalizaciéon de la misma. El tiempo de espera entre la peticion de los datos y el momento en el que empieza
a llegar la respuesta es lo que se conoce como latencia. Hay que tener en cuenta que en el caso de aplicaciones para
dispositivos méviles la latencia es mucho mayor que la de una aplicacién web normal.
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También hay que tener presente que cuando se trata del desarrollo de aplicaciones para teléfonos méviles, la
funcién de teléfono (es decir, realizar y/o recibir llamadas), tiene la prioridad maés alta. Por lo tanto, en el momento
en el que se reciba una llamada, la aplicacién debe proporcionar la forma de mantener el estado en el que ha sido
interrumpida, para volver a ella cuando la llamada termine y el usuario confirme que quiere volver al punto en el que
se interrumpié su ejecucion.

En cuanto a las conexiones, debemos tener presente que pueden fallar y de hecho es algo que sucede con relativa
frecuencia, por ejemplo, por la falta de cobertura en determinadas areas. Esto implica que no podemos dar por sentado
que tendremos el acceso a Internet garantizado y que podremos obtener los datos necesarios para la ejecucion de la
aplicacion.

Aunque el uso de emuladores es util para simular el comportamiento de la aplicacién, hay que tener presente
que se ejecutan en equipos cuya capacidad de procesamiento es superior a la del dispositivo. Por lo cual, es muy
recomendable probarla cuanto antes en el dispositivo para el cual ha sido disefiada y asi evitar comportamientos
indeseados.

ENFOQUES PARA EL DESARROLLO DE APLICACIONES MOVILES
Para el diseno de aplicaciones para dispositivos méviles se consideran cuatro enfoques principales:

Clientes nativos: las aplicaciones se escriben en lenguajes de bajo nivel como C o ensamblador y compilados
en un lenguaje de maquina para un grupo especifico de procesadores y configuraciones hardware, y luego se
ejecuta como codigo nativo en esos dispositivos méviles. El principal beneficio de este enfoque es la capacidad
para utilizar al completo todas las caracteristicas de un hardware determinado. Este enfoque se debe utilizar
si el dispositivo movil tiene un hardware especializado al que solo se puede acceder utilizando una API de C.
Otro beneficio de desarrollar en clientes nativos es que se pueden ajustar los bucles, la gestién de memoria y
el acceso a datos para lograr un alto nivel de rendimiento de la aplicacion. Sin embargo esta potencia y control
tiene un precio. Los desarrollos se hacen para dispositivos que tienen hardware similar, por tanto es necesario
mantener diferentes versiones del cédigo fuente para todos los clientes. Ademés, los lenguajes de bajo nivel no
son tan productivos y por tanto la cantidad de c6digo que hay que escribir para que la aplicacién realice una
determinada operacion es bastante grande. Por ejemplo, si se utiliza C, las asignaciones de memoria se deben
hacer manualmente, lo cual aiiade no solo complejidad y lineas de c6digo, sino también la posibilidad de errores.
Resumiendo, se puede utilizar este enfoque cuando la utilizacién completa del hardware y el alto desemperio
son primordiales. Cuando hay que dar soporte a un gran nimero de clientes méviles o cuando el tiempo de
desarrollo es clave, este enfoque no es la mejor opcién, a menos que sea la inica opcién.

Clientes JME (Java Platform Micro Edition, Plataforma Java Micro Edicion): las aplicaciones se escriben
en Java y se compilan para ejecutarse contra una maquina virtual Java (JVM), disefiada especificamente
para computadoras de mano y clientes méviles. Este enfoque proporciona dos beneficios principales: tiempo
de desarrollo rdapido y la posibilidad de utilizar el mismo cédigo base en un gran ndmero de dispositivos. La
cantidad de c6digo necesario escrito en Java es por lo general menor que si se escribe en un lenguaje de bajo
nivel como C. Esto se debe a que la maquina virtual se encarga de manejar automaticamente muchas de las
operaciones tediosas, entre ellas el manejo de memoria. Esto significa que para realizar la misma operacién se
necesitan pocas lineas de c6digo y menos errores. Ademas, la JVM esta disponible en varios dispositivos, por lo
que la aplicacion cliente trabajara en diferentes dispositivos sin necesidad de mantener multiples versiones.
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Sin embargo, debido a las diferencias en las implementaciones, sera necesario probar la aplicacién sobre cada
plataforma. Los principales inconvenientes de este enfoque son el desempeiio y la flexibilidad. Si la aplicacién
debe caber en un pequerio espacio de memoria o realizar operaciones que requieran mucha CPU (Central
Processing Unit, Unidad Central de Procesamiento), entonces Java no es adecuado. Ademaés, es posible que uno
0 mas dispositivos no tengan la JVM. Resumiendo, si la aplicacién a desarrollar tiene una interfaz estandar y
no requiere acceso especial al hardware, entonces Java es una buena eleccion.

Clientes basados en web: son similares a los clientes web estandar excepto porque se debe tener en cuenta el
disenio de la pagina. Un cliente basado en web se ejecuta dentro del navegador web del dispositivo, desde el cual
accede a la pagina que el servidor web envia utilizando las mismas facilidades que un cliente web de sobremesa.
El principal beneficio de este enfoque es que simplifica el mantenimiento del cliente independientemente de
que las caracteristicas de las versiones cambien. Sin embargo, las aplicaciones deben desarrollarse para que
sean compatibles con el navegador del dispositivo. De otra parte, con la proliferaciéon de las caracteristicas
de la Web 2.0, es mas sencillo crear clientes mas ricos y dindmicos. Los principales inconvenientes para un
cliente basado en web son las caracteristicas, el desemperfio y el modelo de conexiéon. Con un cliente web, el
dispositivo requiere una conexién a un servidor web para que la aplicacién mévil se pueda ejecutar. Esto
significa que si la aplicacién cliente necesita realizar trabajo fuera de linea, que se puede procesar por lotes y
enviar a los servidores centrales solo unas cuantas veces al dia, el enfoque de cliente basado en la web no es la
opcién adecuada. Ademds, si la aplicacién requiere una interfaz de usuario dindmica o acceso a un hardware
I/0 (entrada/salida) especial, es necesario considerar una implementacién alternativa. En resumen, el cliente
basado en web es una buena opcién si el cliente software tiene una interfaz de usuario simple, que puede
mantener una conexion para realizar trabajo util.

Clientes basados en middleware (software que ayuda a una aplicacién a interactuar o comunicarse con otras
aplicaciones, software, redes, hardware y/o sistemas operativos): el disefo de este tipo de aplicaciones utiliza
un conjunto de herramientas y tiempos de ejecucion para abstraer la aplicacion y las tareas de adquisicién
de datos lejos de cualquier dispositivo. El principal beneficio de este tipo de implementacion es el desarrollo
rapido y el mantenimiento del cédigo especifico del dispositivo. En el enfoque midleware se crea una aplicacién
utilizando un conjunto de herramientas de disefio para terceros, en un sistema operativo propietario. Ademas
controla aspectos como lo que se muestra en pantalla, los didlogos, los datos en el lado cliente, la gestion del
estado de conexién del dispositivo y la gestion de los datos fuera de linea. El enfoque midleware funciona
mejor cuando la aplicacion necesita acceder y cambiar datos desde un servidor central. Por lo general, se puede
gestionar y desplegar aplicaciones rapidamente. El inconveniente es el enfoque potencialmente estrecho de
las capacidades y la incapacidad para utilizar funciones hardware especializadas sobre los dispositivos. Las
plataformas midleware generan cédigo que no es adecuado para situaciones de alto rendimiento. Finalmente,
el enfoque midleware es muy similar al enfoque JME, pero mas especializado y generalmente construido en
torno a las bases de datos de las aplicaciones.

En conclusién, cada selecciéon tiene sus beneficios e inconvenientes que determinan qué enfoque de desarrollo
encaja mejor con las necesidades de desarrollo. Si la aplicacién requiere un alto desempefio o un cédigo para
funcionalidades especificas del hardware, una aplicaciéon nativa sera la mejor opcion. Si el cliente necesita ejecutarse
sobre una amplia gama de dispositivos y manipulacién de datos fuera de linea, el enfoque midleware es el mejor. Si
es una aplicacion sencilla en la que la operacién puede depender del estado de conexién, entonces el cliente basado en
web es una buena opcién. Finalmente, si la aplicacién requiere una interfaz de usuario especializada o un cédigo del
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lado cliente especializado, pero no requiere el poder de una aplicaciéon nativa, entonces, el enfoque JME es una buena
opcion. La Tabla 1.1 recoge los beneficios y los inconvenientes de cada opcion.

Tabla 1.1 Beneficios e inconvenientes de los diferentes enfoques para el desarrollo de
aplicaciones para dispositivos moviles

Arquitectura Beneficios Inconvenientes

Cliente nativo - Aplicaciones sofisticadas y control sobre - El mas alto nivel de esfuerzo de
el entorno local desarrollo
- Capacidades multitarea sobre muchas - Diferente cédigo base para diferentes
plataformas dispositivos

Java ME - El mismo cddigo base puede soportar - Algunos limites de capacidad (no
multiples aplicaciones multitarea)
- Aplicaciones mas sofisticadas - Requiere prueba y adaptacion para las

plataformas

Navegador web - Desarrollo rapido - Menos sensible y capas que las
- No requiere mantenimiento del codigo aplicaciones nativas
cliente

- Métodos Web 2.0 disponibles
- Trabajo con un amplio rango de
dispositivos moviles

Midleware movil - Alto nivel de capacidad con reducido - Tasas adicionales de licencia
esfuerzo de desarrollo - Curva de aprendizaje y esfuerzo de
integracion potencialmente grande

Los proveedores cuentan con centros de desarrollo a disposicion de los usuarios, por tanto es de gran ayuda
visitarlos y analizar las sugerencias en cada caso. Algunos de ellos se muestran en la Tabla 1.2.

Tabla 1.2 Centros de desarrollo

Proveedores Centros de desarrollo

Sony Ericsson http://developers.sonyericsson.com
Nokia http://forum.nokia.com

Samsung http://developers.samsungmobile.com
Motorola http://developer.motorola.com
BlackBerry http://www.blackberry.com/developers
IPhone http://developer.apple.com/iphone

LG Mobile http://developer.lgmobile.com
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TECNOLOGIAS DISPONIBLES

Se presenta en este punto una breve introduccién a las principales tecnologias y sistemas operativos para

dispositivos méviles que hay actualmente.

ANDROID

Android es una plataforma formada por un conjunto de software en estructura de pila (software stack) que incluye
un sistema operativo, software para conectar aplicaciones (middleware) y aplicaciones base. E1 SDK (Software
Development Kit, Kit de Desarrollo de Software) de Android proporciona varias herramientas y API (Applications
Programming Interface, Interfaz de Programacién de Aplicaciones) que son necesarias para desarrollar aplicaciones
Android. Estas aplicaciones se desarrollan en lenguaje Java.

Android esta desarrollado por Open Handset Alliance (OHA), una agrupacion de 78 compaiias para desarrollar
estdndares abiertos para dispositivos méviles y que esté liderada por Google. Inicialmente Android fue desarrollado
por la compaiia Android Inc., que fue comprada en el afio 2005 por Google. El sistema operativo se anunci6 el 5 de
noviembre de 2007. Google libera la mayoria del cédigo Android bajo una licencia Apache (licencia libre y de c6digo
abierto). Desde su creacion ha ido pasando por diferentes versiones, desde la versién primera (1.0) hasta la actual (4.0,

denominada también Ice Cream Sandwich).

Android se ha convertido de forma rapida en uno de los SO de méviles con mayor presencia. Actualmente2 hay mas
de 200 millones de dispositivos méviles Android activados y cada dia se activan mas de 550.000 nuevos dispositivos en
137 paises y regiones. Esto representa un 32,9% de la cuota del mercado a escala mundial de los teléfonos Smartphone,
por delate de Symbian OS y iOS. Android presenta varias ventajas que han hecho posible su gran éxito: (i) el ser
c6digo abierto con licencia Apache, lo cual permite que un desarrollador pueda, no solo ver el cédigo, sino mejorarlo
y ampliarlo, (i) dar libertad al usuario del dispositivo para instalar el software que crea oportuno sin imponer que
sea software propietario, (iiz) los desarrolladores tienen libertad para desarrollar cualquier software y ofertarlo a los
usuarios (dispone de una amplia comunidad de desarrolladores), (iv) no estd limitado a determinados proveedores,
operadoras o fabricantes, etc.

La Figura 1.5 muestra la arquitectura del sistema operativo Android que estd organizado en cuatro grandes
bloques:

Aplicaciones (Applications): proporciona un conjunto de aplicaciones de usuario como cliente de correo
electrénico y de mensaje de texto SMS, calendario, mapas, navegador, agenda de contactos, etc.

2 http:/ lwww.android.com/ developers /
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Framework de Aplicaciones (Applications Framework): es un conjunto de aplicaciones en forma de servicios
y sistemas disponibles al desarrollador que le facilitan aspectos como acceso al hardware del dispositivo, acceso
a informacién de localizacion, servicios de background, lanzar alarmas y notificaciones, etc. Alguno de estos
servicios o sistemas mds importantes se describen a continuacion. Sistema de Visualizacion (View System), que
facilita el desarrollo de aplicaciones con potentes interfaces de usuario, Suministrador de Contenidos (Content
Providers), gestiona el acceso a datos entre aplicaciones, Gestor de Fuentes (Resource Manager), gestiona
el acceso a fuentes que no son de la aplicacién como imdagenes, texto, etc., Gestor de Actividades (Activity
Manager), gestiona el ciclo de vida de las aplicaciones, etc.

Librerias (Libraries): Android incluye un conjunto de librerias C/C++ que usan otros médulos del sistema
operativo y estdn accesibles a los desarrolladores de aplicaciones a través del Framework de Aplicaciones.
Algunas de estas librerias incluyen funcionalidades como la libreria estdndar de C para dispositivos embebidos
Linux (System C library), funcionalidades multimedia para video, audio e imagen (Media Libraries),
visualizacion de graficos 2D y 3D (Surface Manager), funcionalidades par optimizar el tratamiento de graficos
3D (3D Libraries), motor de navegaciéon web que da soporte al navegador web de Android (LibWebCore), motor
de base de datos relacional (SQLite), etc.

Entorno de Ejecucion (Android Runtime): el entorno de ejecucion estd formado por las librerias del nticleo del
sistema operativo (Core Libraries) y por la maquina virtual (Dalvik Virtual Machine). Es el motor que ejecuta
los programas. El médulo Core Libraries proporciona muchas de las funciones disponibles en la libreria base de
Java asi como funciones especificas de Android. La médquina virtual Dalvik se encarga de interpretar el codigo
del programa y de ejecutarlo apoydndose en el Kernel del sistema operativo. Cada aplicacion pone en ejecucién
su propio proceso, el cual tiene asociado una instancia propia y exclusiva de la maquina virtual Dalvik. Dalvik
ha sido desarrollada de tal forma que puede haber multiples maquinas virtuales (MV) ejecutandose a la vez
en un mismo dispositivo (precisamente ésta fue la razén por la que no se utilizé la MV de Java ME, Java
Mobile Edition). Dalvik es una méquina virtual basada en registros y ejecuta ficheros de c6digo con un formato
especial, denominado Ejecutable Dalvik (ficheros con extension .dex). Este formato esté especialmente pensado
para optimizar el uso de la memoria. No obstante, esto no significa que no podamos usar un compilador de Java
para desarrollar aplicaciones para esta MV. Dalvik es capaz de ejecutar clases compiladas por un compilador de
Java siempre que hayan sido transformadas previamente al formato .dex por herramientas de poscompilacién
(dx tools).

Linux Kernel: Android se basa en la version 2.6 de Linux para implementar servicios bases de sistema como
seguridad, gestion de memoria, gestion de procesos, pila de red y varios drivers, etc., todos ellos integrados en
el Kernel. El Kernel también constituye una capa de abstraccion entre el hardware del dispositivo y el resto de
los componentes y médulos de la pila de software del sistema operativo.
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Figura 1.5. Estructura de la pila de software del S.O Android (fuente: hitp:/ / developer.android.com/guide/ basics | what-is-android.html)

BLACKBERRY

BlackBerry esta desarrollado por la compania RIM (Research In Motion). Los méviles BlackBerry destacan
principalmente por su capacidad de enviar y recibir correo electrénico por Internet a través de los operadores que
ofrecen este servicio. Actualmente, del mercado mundial, BlackBerry asume un 2,9% de los méviles vendidos, y el 11%
de los smartphone, si bien su mayor cuota de mercado estda en EE.UU.

Los dispositivos BlackBerry montan el sistema operativo BlackBerry OS, desarrollado por RIM. Este sistema
operativo es propietario, con lo cual no hay informacién publica relevante sobre su disefio ni arquitectura. A dia de
hoy la dltima version del sistema operativo es BlackBerry OS 7. Las versiones del sistema operativo tienen un Kernel
que se basa en Java, montando la mayoria de los dispositivos arquitecturas ARM. ARM no construye sus propios
chips CPU pero da licencia a terceros para que los fabriquen. El sistema operativo divide la memoria del dispositivo
en tres secciones:

Memoria de aplicacion: espacio de memoria destinado para albergar las aplicaciones.
Memoria de dispositivo: espacio para almacenar ficheros y otras fuentes.
Memoria para tarjeta: espacio de almacenamiento adicional.

BlackBerry OS es un sistema operativo multitarea. Esto significa que puede ejecutar mas de una aplicacién a la
vez. Por ejemplo, mientras que se estd realizando una llamada, el usuario puede cambiar y consultar el calendario
o los contactos sin cortar la llamada. Estas aplicaciones quedan en modo background y continda asi su ejecuciéon
dando la ejecucion e interaccién del usuario a otras aplicaciones. Hay que tener en cuenta que muchas aplicaciones
ejecutandose en background puedan dar la sensacion de que no hay mucha carga de ejecucion para la maquina, pero
lo cierto es que hay un alto consumo de memoria.
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SYMBIAN

El sistema operativo Symbian viene como evolucién del sistema operativo Epoc, este fue desarrollado por Psion
en sus agendas electronicas durante los 80. Symbian es el resultado de adaptar Psion a dispositivos méviles y tiene
diferentes variantes segun el dispositivo en el que se utilice.

Concretamente Symbian Inc desarroll6 el sistema operativo base y les vendid la licencia a los distintos fabricantes
de teléfonos moviles. Estos a su vez construyen interfaces de usuario sobre este sistema operativo base y personalizan
el sistema para propésitos especificos.

De todos los fabricantes de méviles es Nokia el que mas ampliamente ha utilizado este sistema operativo. Ha
desarrollado varias versiones del sistema, que denomina Series, esta la Serie60, Serie70, Serie80 y Serie90, siendo la
Serie60 la que mas amplio uso ha tenido.

Sony Ericcson por ejemplo también utiliza Symbian, con su plataforma UIQ, en sus dispositivos, por ejemplo, en
el modelo P800 o Motorola en el A1000.

Como hay muchas combinaciones de SO y UI, habra también muchos kits de desarrollo (SDK), por ejemplo para la
Serie60 hay SDK version 6.1, 7.0, 8.0 y 9.0. Si nos centramos en la Serie60, tenemos que para cada edicién de un SDK
hay ampliaciones con mejoras llamadas paquetes de caracteristicas o FP (Feature Pack), asi tenemos:

SDK for 1st Edition.
SDK for 1st Edition, FP1.
SDK for 2st Edition.
SDK for 2st Edition, FP1.
SDK for 2st Edition, FP2.

Ademas, para cada kit de desarrollo hay una variante en funcién del IDE en el que se instale por lo que habra
variantes diferentes.

Normalmente el entorno de desarrollo viene preparado para estar programado en C o C++ y aporta el emulador
de la Serie para la que esta desarrollado. En las siguientes secciones comentaremos mas acerca de la estructura de
un programa en Symbian y las caracteristicas de sus emuladores.

PALM OS (WEBOS)

Palm OS es el sistema operativo de los dispositivos méviles desarrollados por la empresa Palm Inc. Esta empresa
tuvo un gran auge con sus agendas electrénicas o PDA. Comenzé su actividad en 1996, creando Palm OS, un sistema
operativo facil de utilizar con pantallas tactiles e interfaces de usuario gréficas.

Palm OS ha tenido una gran evolucién de versiones desde la 1.0 hasta la 5.0, luego pasé a llamarse Palm OS
Cobalt. Este tltimo es un sistema operativo basado en Linux, que evolucion6 para denominarse webOS en 2009, el
primer dispositivo que lo incluia fue Palm Pre. La compafiia Palm Inc, fue adquirida en 2010 por HP y, actualmente,
HP utiliza webOS en sus dispositivos méviles y tablets, como Pixi, Veer y HP TouchPad.

En diciembre de 2011 la compania Hewlet-Packard liber6 el c6digo de webOS y en la actualidad es un sistema de
c6digo abierto.
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WINDOWS PHONE

Este sistema operativo fue lanzado a finales del afio 2010 tras dos afios de desarrollo. Entre las novedades se
encuentra la denominada interfaz de usuario “Metro” basada en la utilizaciéon de mosaicos dindmicos que muestran
informacion util al usuario. Ademads se introduce el concepto de HUB, en donde se centralizan las acciones y las
aplicaciones se agrupan por el tipo de actividad que representan. Por lo tanto, encontraremos diferentes HUB, por
ejemplo, de Office, Xbox Live, Imdgenes o Zune, desde los cuales tenemos acceso a tareas especificas. También incluye
el motor de Internet Explorer 9, con soporte para HTML5, multitarea en aplicaciones de terceros e integracién con
Xbox 360 y Kinet.

Este sistema ha evolucionado en poco tiempo, desde la version 7 (estable desde 2010), hasta la 7,5 y ya se habla
de la version 8. [1]3.

Analicemos la arquitectura de Windows Phone desde el punto de vista de su modelo hardware y software.

Modelo de Hardware: para ejecutar Windows Phone y asegurar la consistencia de todos los usuarios del
sistema, es necesario que el teléfono cuente con unas caracteristicas minimas, o lo que se conoce como Chassis
1, que constituyen las especificaciones que debe seguir todo fabricante que quiera crear terminales con soporte
para este SO:

Procesador: ARMv'7 Cortex/Scorpion a 1 GHz.

Procesador grdfico: soporte hardware completo de DirectX9.
Memoria: RAM 256 MB y ROM 8 GB.

Sensores: A-GPS, acelerémetro, brdjula, iluminacién y proximidad.
Cdmara: 5 Mpx con flash y botén fisico de disparo.

Multimedia: aceleracion de audio y video por hardware.

Pantalla: capacitiva, resolucién 800 x 480.

Botones fisicos: Inicio, Buscar y Atras.

Las especificaciones se iran adaptando a los nuevos tipos de teléfonos méviles, manteniendo la experiencia del
usuario independientemente del dispositivo que utilice.

Modelo Software: Windows Phone se basa en el Windows CE 6.0 R3, el cual tiene soporte para Silverlight
Mobile, Internet Explorer Embedded, entre otras tecnologias. También soporta Flash Lite de forma nativa en
el sistema (no disponible en la version Woindows Phone 7.5).

La Shell y la plataforma de aplicaciones residen en memoria de usuario, mientras que el Kernel, los drivers y
el sistema de archivos, networking, el sistema de rendering y graficos y el sistema de actualizaciones, residen
en el espacio de Kernel. El sistema es de 32 bits, con lo cual maneja 4 GB de memoria, dos de los cuales son
para procesos y los otros dos para el Kernel.

3 Consultar bibliografia en la pagina web del libro.
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La Figura 1.6 representa el modelo de software en el SO Windows Phone.
Ejecucion de la aplicacion

Modelo Modelo Integracion
Aplicacion U Nube

Kernel

Hardware

Figura 1.6. Modelo de software en Windows Phone

Modelo de aplicacion: las aplicaciones en Windows Phone se muestran en forma de paquetes XAP. Este es
un archivo comprimido que contiene los recursos originales de la aplicacion que estamos desarrollando. Para
instalar una aplicacién en el dispositivo, es necesario hacerlo a través del Marketplace (la tienda oficial de
Microsoft), previo registro como desarrolladores, si nos interesa vender la aplicacién. A cada aplicacién se le
asigna un ID udnico y un certificado de seguridad una vez la aplicacion ha sido aprobada por el Marketplace.
Si comprobamos el modo del certificado, podremos saber si estamos en modo de prueba o en modo completo,
pudiendo cambiar la forma en la que la aplicacién se comporta y evitando asi la creacion de versiones “lite” tal
y como ocurre con otras plataformas.

Modelo de IU: la interfaz de usuario estd formada por: (i) elementos, es decir, todo control que se muestra al
usuario, (if) paginas, una asociacién légica de elementos y (iii) sesiones, conjunto de interacciones que realiza
un usuario sobre la aplicacién. También puede incluir otras aplicaciones.

Integracion con la nube: en la versién actual del kit de desarrollo no existen API que permitan a las
aplicaciones acceder directamente a estos servicios, pero se espera que lo hagan en préximas actualizaciones.

Ejecucion de aplicaciones: Windows Phone proporciona dos frameworks: (i) Silverlight, permite crear
aplicaciones multimedia que se ejecuten de forma nativa en Windows Phone, con una interfaz creada en XAML,;
(it) XNA, es una solucién Multiscreen (Xbox, Windows, Windows Phone) 2D y 3D que permite crear juegos de
calidad profesional. Ambos frameworks se ejecutan sobre sandbox de .NET, lo cual facilita el acceso a hardware,
sensores, almacenamiento, etc. Esto implica que la aplicacién nunca tenga acceso nativo al sistema y que se
ejecute aislada del sistema y de otras aplicaciones, por lo que no podran compartir espacio de almacenamiento
ni ningun otro tipo de informacién, a menos que utilicemos para ello servicios externos a la nube. La nueva
version de las herramientas de desarrollo para Mango (Windows Phone 7.5) permite tener aplicaciones mixtas,
en las que se utilice Silverlight para la IU y XNA para los graficos 3D, lo cual ofrece al usuario una experiencia
interactiva maés rica.

I10S

A mediados de 2007 la tecnologia Apple nos ofrecié iOS (inicialmente llamado IPhone OS), desarrollado
originalmente para el IPhone y con él, una nueva definicién del teléfono mévil. Mas tarde fue introducido en el iPod
Touch y actualmente en el IPad. Las actualizaciones de este S.O se enumeraron desde la 1.x hasta la 1.1.5. La versién
1.0 incorporaba aplicaciones como Mail, Fotos, iPod, Calculadora, entre otras, presentes en las versiones actuales y
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que no han sido modificadas practicamente ni en sus interfaces ni en sus funcionalidades. Un afio después, en 2008, se
lanzé el iPhone OS 2.0, cuyas actualizaciones llegaron hasta la 2.2. Comenz6 entonces la revolucién de las aplicaciones
moéviles y uno de los modelos de negocio més productivos existente hoy en dia. En el anio 2009 se lanzé el iPhone
OS 3.0 que evolucion6 hasta la version 3.1.3, la cual incluia el Spotlight (para realizar bisquedas en el dispositivo),
también ofrecia la posibilidad de incluir la API de Google Maps, las operaciones de copiar/cortar/pegar, interconexiéon
por BlueTooth o P2P y librerias GPS. Esta version fue soportada por los iPhones e iPads de primera generacién. En
2010, empez6 a llamarse i0S y se realiz6 el lanzamiento de la versién 4.0 del S.O. La version 4.1.2 fue la dltima en
los iPhone 3G y los iPod Touch de segunda generacion. A finales de 2011 se lanz6 la version iOS 5, con una interfaz
mejorada y funcionalidades como la presencia de un asistente personal Siri, facilidades para la sincronizacién sin
cables, un centro de notificaciones mejorado, el servicio de iMessage, la navegacién web con pestafias, entre otras.
La version i0S 5 solo se podra instalar en los Apple TV (segunda generacién), iPhone 3GS, iPhone 4, iPhone 4S, iPod
Touch (tercera y cuarta generacién) y en los dos modelos de IPad actuales (ver Figura 1.7).

[ 6.29 | [ 119 | [ 25 | (T35 |
07 07 08 08
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del iPhone en para disponer de
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Lanzamiento  Disponible
de iPhone 4S i0S 5

Figura 1.7. Evolucion del sistema operativo iOS
(fuente: http:/ | sites.google.com / site/ tecnologiaiostm / historia)

La arquitectura iOS se basa en capas, donde las capas méds altas contienen los servicios y las tecnologias
indispensables para el desarrollo de aplicaciones y las capas mas bajas son las encargadas de controlar los servicios
basicos.

Cocoa Touch: posee tres frameworks: (i) UIKit, contiene todas las clases necesarias para el desarrollo de una
interfaz de usuario; (iz) Foundation Framework, define las clases basicas de acceso, manejo de objetos y (iii)
servicios del S.O. Estas frameworks proporcionan la API de Cocoa para desarrollar aplicaciones (ver Figura
1.8).
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Cocoa Touch

Media

Core Services

Core 08

Figura 1.8. Arquitectura del sistema operativo iOS
(fuente: http:/ / sites.google.com/ site/ tecnologiaiostm / desarrollo-de-aplicaciones/ arquitectura-ios)

Media: esta capa proporciona los servicios graficos y multimedia a la capa superior.

© RA-MA

Core Services: esta capa proporciona los servicios fundamentales del sistema utilizados por todas las

aplicaciones.

Core OS: en esta capa se encuentran servicios de bajo nivel como los archivos de memoria, manejo de memoria,

seguridad y drivers del dispositivo.

La Tabla 1.3 recoge algunas de las caracteristicas més relevantes de los sistemas operativos.

Tabla 1.3 Sistemas Operativos

S.0

Caracteristica

Version 2012

Dispositivos

Interfaz

SDK

Aplicaciones

Firma

Proveedores

Symbian

Nokia Belle

Smartphone
Apuntador
Teclado

Gratuito

Nativas y JME

Obligatoria

Nokia, Sony
Ericsson,
Samsung,
Siemens

Windows
Phone

Windows
Phone 8 o
Apollo

Smartphone
PDA

Apuntador
Teclado

Gratuito/IDE
pagado

Nativas
Compact
Framework

Opcional

HP, HTC,
Samsung, Dell

i0S 5.0.1

IPhone 3
y 4S

Touch
IPhone
Delevoper
Program
Nativas y
JME
Obligatoria

IPhone,
IPhone 3G

Garner OS
5.5

PDA

Apuntador
Teclado

Gratuito

Nativas y
JME
Opcional

Familia
Palm

Android

4.0.4 Ice
Cream

Sandwich

Smart-
phones

Touch

Apuntador

Gratuito

Nativas y
JME
Opcional

HTC, LG,
Samsung

BlackBerry

0S 7.0

Smart-
phones

Teclado

Gratuito

JME

Opcional

Familia
BlackBerry
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Tabla 1.4 Plataformas de desarrollo nativas

Symbian

Windows Phone

IPhone

Palm

Eclipse + Plugin + SDK
Visual Studio + SDK + Plugin

Visual Studio + SDK
XCode + SDK

Codewarrior + SDK

Tabla 1.5 Sistemas operativos

Nokia

Sony Ericsson
Samsung
Motorola
BlackBerry
Android

Palm

Windows based

Plugin (SDK)
Plugin (SDK)
SDK
SDK
Plugin (SDK)
Plugin (SDK)

SDK

Plugin (SDK)

SDK Plugin (SDK)
Plugin (SDK) SDK
Plugin (SDK) Plugin (SDK)
SDK
SDK
SDK SDK

SDK
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DESARROLLO DE APLICACIONES MOVILES

En esta seccion se presenta una descripcion de las herramientas que hay actualmente en el marco del desarrollo de
aplicaciones para dispositivos méviles. El interés se centra en los lenguajes, entornos y emuladores méds importantes
¥y que estan en uso.

LENGUAJES DE PROGRAMACION

Existe una gran variedad de lenguajes para el desarrollo de aplicaciones para dispositivos méviles. A continuacién
se describen las principales caracteristicas de cada uno de ellos.

Blackberry

Hay dos tipos de aplicaciones que se pueden desarrollar para dispositivos BlackBerry: aplicaciones Web y
aplicaciones Java. El desarrollo Web de BlackBerry estd pensado para usar estdndares de web y herramientas my
extendidas y conocidas como Eclipse o Microsoft Visual Studio. En el desarrollo de aplicaciones Java se utiliza el
lenguaje de programacion Java y se puede utilizar también varios entornos de desarrollo.

Las aplicaciones Java para BlackBerry se escriben en Java ME (Java Micro Edition). Los Smartphone de
BlackBerry estan disenados para ejecutar aplicaciones Java. Como minimo soportan compatibilidad para MIDP 1.0
y CLDC 1.0 (ver Seccién 1.5). Ademas, los dispositivos que tienen la versién BlackBerry Device Software v4.0 o una
version superior son compatibles ademas con MIDP 2.0/CLDC1.1.

BlackBerry proporciona una API de Java que permite desarrollar aplicaciones con las siguientes caracteristicas:

Aplicaciones con interfaces de usuario personalizadas.

Capacidad de almacenamiento y recuperacién de datos en local en el dispositivo.
Escucha y captura de eventos de la interfaz y del sistema.

Comunicaciones seguras mediante HTTP y TCP.

Cobertura de red y compatibilidad con el modo roaming.

Las aplicaciones para dispositivos BlackBerry deben tener un cierto equilibrio, por lo que es necesario considerar
algunas cuestiones en el diseno: el tamano de la pantalla es mas pequeio, por lo que puede mostrar un ntimero
limitado de caracteres, tiene velocidades de procesador algo bajas, las redes inalambricas tienen periodos de latencia
mas largos que las LAN estandar, tienen poca memoria, la bateria no dura mucho y solo se puede mostrar una pantalla
alavez. Todas estas consideraciones afectan al disefio y se deben tener en cuenta no solo para dispositivos BlackBerry
sino para cualquier otro dispositivo mévil.

Symbian

Los entornos de desarrollo para Symbian estédn pensados principalmente para el lenguaje de desarrollo C++, si
bien siempre se puede programar en Java Micro Edition, ya que la mayoria de los dispositivos Symbian incluyen un
gestor de aplicaciones para esta plataforma.
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Si nos decidimos a programar en C++, deberemos de utilizar la SDK asociada a la serie a la que pertenece el
dispositivo para el que vamos a programar, en este SDK se encontraran todas las librerias que podemos utilizar para
esta serie.

Si decidimos programar en J2ME, el CLDC en la versién que soporte la serie para la que vamos a desarrollar, que
normalmente serd la CLDC 1.1 y utilizar las MIDP 2.0 de la version de la serie a la que pertenece nuestro dispositivo.
Siempre es posible utilizar tanto CLDC como MIDP genéricos, pero en este caso no tendremos acceso al 100% de la
funcionalidad que la serie de nuestro dispositivo nos ofrece.

Palm OS (webOS)

Los lenguajes de programacion para la plataforma Palm han evolucionado desde el lenguaje C++, para los antiguos
dispositivos monocromo, hasta la programaciéon en HTML5 con JavaScript y CSS, para los nuevos sistemas webOS
y Enyo. Enyo nos permite desarrollar aplicaciones no solo para dispositivos méviles, se puede programar para PC y
tabletPC. La aplicacién siempre se ejecutard dentro de un navegador, siendo compatible con la mayoria de ellos, desde
Internet Explorer, Safary, FireFox, etc.

Enyo proporciona un potente modelo de encapsulacién que permite construir y realizar funcionalidad. Estas piezas
de encapsulacion se denominan componentes. Por ejemplo resulta sencillo construir una marca entrada y una marca
etiqueta para construir un componente entradaEtiquetada.

Veamos un sencillo ejemplo de programacién con Enyo.

<!doctype html>
<html>
<head>
<title>Enyo</title>
<script src="enyo-2.0b/enyo.js” type="text/javascript”></script>
</head>
<body>
<script type="text/javascript”>
new enyo.Control ({content: “Hello From Enyo”}) .write();
</script>
</body>
</html>

En la marca de cabecera cargamos el archivo enyo.js que esté en la carpeta enyo-2.0.b.

El c6digo javascript del cuerpo genera un control que puede utilizarse como una marca HTML, puede tener clases,
atributos, estilos, etc.

Por ejemplo el siguiente cédigo:

new enyo.Control ({content: “Hello From Enyo”, classes: “foo”,
style: “color: red”, attributes: {tabIndex: 0}}).write();
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genera la siguiente marca HTML en el navegador:

<div class="foo” style="color: red;” tabIndex="0”>Hello From Enyo</div>

La potencia del framework viene cuando combinamos més de un control.

new enyo.Control ({
components: [
{content: “Hello From Enyo”},
{tag: “hr”}
]

}) .write () ;

En el c6digo anterior hemos definido dos controles, content y tag agrupados como un componente.

Este nuevo control encapsula dos controles, por esto se denomina componente. Realmente los controles son un tipo

de componente. El control exterior es el responsable de gestionar sus controles internos, sus mensajes, sus referencias
y ciclo de vida.

new enyo.Control ({

components: [
{name: “hello”, content: “Hello From Enyo”, ontap: “helloTap”},
{tag: “hr”}

1,

helloTap: function() {
this.$.hello.addStyles (“color: red”);

}

}) .write () ;

El codigo anterior amplia el componente con eventos, hemos afiadido el evento ontap que recoge tanto los clics

del raton como los toques de las pantallas tactiles e invoca al método hellotap que cambia el estilo del objeto a rojo,
cuando se pulsa en él.

Por tdltimo, Enyo contiene un generador de constructores llamado enyo.kind que nos permite reutilizar el cédigo,
es decir, nuestros componentes, de manera muy sencilla.

enyo.kind ({

name: “Hello”,

kind: enyo.Control,

components: [
{name: “hello”, content: “Hello From Enyo”, ontap: “helloTap”},
{tag: “hr”}

i

helloTap: function() {
this.$.hello.addStyles (“color: red”);
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// make two, they’re small
new Hello () .write();

new Hello () .write();

El c6digo anterior crea un control llamado Hello que posteriormente es instanciado dos veces, como si fuese una
simple clase de JavaScript. A partir de ahora tendremos el control Hello que podremos utilizar dentro de nuestro
c6digo javascript sin preocuparnos de su implementacion y sin tener que repetir cédigo.

Objective-C

Objective-C es una extension orientada a objetos de la sintaxis del lenguaje de programacién C, utilizado en Mac
OS Xy GNUStep. Para desarrollar aplicaciones con este lenguaje, es recomendable saber programar en C, y si ademés
sabes programar en C++, Java o C#, sera mas facil. Es importante tener presente que en iPhone no existe recolector
de basura, por lo que es recomendable estudiar en profundidad la documentacién oficial de Apple sobre Objective-C
y la gestiéon de memoria [2]4, [3]5, aunque en la versién Objective-C 2.0 se incluye un recolector de basura, este no
es soportado por iPhone, por lo que cada instancia tiene un contador de referencias y cuando llega a cero el objeto es
liberado de la memoria. Es decir, que los objetos de la API oficial de Apple a los que les pasemos objetos creados por
nosotros, para almacenarlos en su interior, los retendra aumentando el contador y los liberara cuando el objeto sea
destruido.

Al estudiar Objective-C encontrardas que comparte elementos comunes con el lenguaje C como: sentencias de
control de flujo (if, for, while, etc.); tipos de datos fundamentales; estructuras y punteros; conversiones implicitas y
explicitas entre tipos; el &mbito de las variables (globales, estdticas o locales); las funciones y su sintaxis; las directivas
del preprocesador (anadiendo Objective-C las suyas, asi como las llamadas directivas del compilador).

Las clases en Objective-C se crean mediante dos archivos: un ./ para definirla y un .m para implementarla. Por
tanto, hay que utilizar #import para decirle al compilador las clases que vamos a utilizar en nuestro cédigo. Se puede
utilizar los mismos tipos que en C, mas lo que anade el propio lenguaje.

En Objective-C se aplican los enlaces dinamicos donde las variables son identificadas por el runtime y no por el
compilador y solo si existen punteros de objetos. De esta forma, comparando los lenguajes C y C++ con Objective-C
veremos que los métodos y funciones deben ser llamados en alguna parte del c6digo y se comprueba que efectivamente
funcionen (en C++ por parte del compilador). En Objective-C el programa compila todos los datos y los objetos son los
que deciden cuédndo ejecutar los métodos.

Es un lenguaje interpretativo que permite crear clases, métodos y funciones, pero su sintaxis cambia al ser mas
dindamico. El lenguaje Objective-C es débilmente tipado, al contrario que C++, que es un lenguaje mayormente tipado
y debe realizar conversiones de lenguaje para que sea mas ordenado por defecto, pero al igual que el lenguaje C. Esto
significa que una variable puede tener muchos valores distintos, por ejemplo, valores no especificos, cambiantes, que
aunque estén relacionados no son los mismos.

4 Consultar bibliografia en la pagina web del libro.

5 Consultar bibliografia en la pagina web del libro.
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Objective-C sobresale por su parte dindamica:

Memoria dinamica. Objective-C crea sus objetos siempre en memoria dindmica para darles menos peso y
favorecer la rapidez del proceso, contrario a lo que sucede con los lenguajes C y C++, los cuales deben adaptarse
a la memoria dindmica y tienen un mayor peso.

Tipos dinamicos. El tipado en Objective-C es mucho més amplio que en C++.

Introspeccion. Se utiliza para preguntar acerca de los datos y su uso, por ejemplo, cuando se requiere
informacion sobre a qué clase u objeto pertenece tal variable.

Enlace dinamico. Objective-C busca en el propio objeto y clase la funcién de ejecucion, a diferencia, por
ejemplo, del lenguaje C++ donde en el compilador se decide qué funciones realizar para el objeto.

Carga dinamica. Cuando se cargan las funciones del programa, el lenguaje busca nuevas formas de
actualizarse y completar lo que le falta (por ejemplo, a través de plugins).

Desde el punto de vista de la conexién, en Objective-C se distinguen tres tipos: (i) conexion outlet, punteros de un
objeto a otro; (ii) conexion target action, mensaje action hacia un target y (iii) Bindings, conexién de objetos distintos.

A continuacién, un ejemplo de “Hola mundo” para iPhone:

Makefile (GNU make):

CC=arm-apple-darwin-cc
LD=$ (cc)
LDFLAGS=-1lobj —-framework CoreFoundation —framework Foundation —framework UIKit —-framework
LayerKit —-framework CoreGraphics
all: SampleApp
SampleApp: mainapp.o SampleApp.o
$(LD) $(LDFLAGS) -v -o $@ S”
.m

$(CC) =-c S$(CFLAGS) $(CPPFLAGS) $< -o $S@

o
O
o

rm —f *.o SampleApp

mainapp.m

#import <UIKit/Uikit.h>

#import “SampleApp.h”

Int main(int argc, char **argv)

{
NSAutoreleasePool *poll = [[NSAutoreleasePool alloc init];
Return UIApplicationMain (argc, argv, [SampleApp Class]);
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SampleApp.h

#import <CoreFoundation/CoreFoundation/h>
#import <Foundation/Foundation.h>
#import <UIkit/CDStructures.h>
#import <UIkit/UIWindow.h>
#import <UIkit/UIWView-Hierarchy.h>
#import <UIkit/UIHardware.h>
#import <UIkit/UIKit.h>
#import <UIkit/UIApplicacition.h>
#import <UIkit/UITextView.h>
#import <UIkit/UIView.h>
@interface SampleApp : UIApplication {
UlView *mainView;
UlITextview *textView;
}
@end

SampleApp.m

#import “SampleApp.h”
@implementation SampleApp

- (void) applicationDidFininshLaunching: (id) unused

UIWindow *window;
structCGRect rect 0 [UIHardware
fullScreenApplicationContentRect];

rect.orgin.x = rect.origin.y = 0.0f;

window = [[UIWindow alloc] iniWithContentRect: rect];
mainview = [[UIView alloc] iniwithFrame: rect];
textView = [[UITextView alloc]

iniWithFrame: CGRectMake (0.0f, 0.0f, 320.0f, 480.0f)];
[textView setEditable:YES];
[textView setTextSize:14];
[window orderFront: self];
[window makeKey: self];
[window setHidden: NOJ;
[window setContentView: mainView];
[mainView addSubview:textView];
[textView setText:@”Hello World”]
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Podriamos concluir que Objective-C y el lenguaje C realizan procesos similares pero mejorados, y que en C++
hay mayores diferencias [4]6. Ademés es un lenguaje muy limpio, pequefio y por ende, mucho mas rapido y facil de
aprender que C++. Queda claro que la evolucién de estos lenguajes ha permitido dejar de lado lo estatico y pasar a lo
dindmico.

Lenguajes .net (Windows Phone)

NET es una plataforma de desarrollo de aplicaciones que se ejecutan en un entorno aislado del S.O y que recibe el
nombre de runtime. Entre las caracteristicas que ofrece esta plataforma encontramos que: (i) es orientada a objetos,
(it) permite desarrollar aplicaciones en varios lenguajes, (iiz) proporciona un modelo de programacién consistente
que permite el desarrollo de diferentes modelos de aplicaciones (por ejemplo: web, Windows, consolas, méviles,
etc.) orientadas a diversos dispositivos hardware (PC, tablet, pocket PC, etc.), (iv) es compatible con aplicaciones
desarrolladas con modelo COM, (v) permite integrar aplicaciones de otras plataformas y S.O, ya que implementa
estdandares como XML, WSDL, SOAP, entre otros [5]7.

El componente fundamental y que contiene todos los elementos necesarios para el desarrollo de aplicaciones es
.NET Framework, que esta formado por:

Entorno de ejecucion CLR (Common Language Runtime, Tiempo de Ejecucién en Lenguaje Comun):
encargado de administrar la memoria, la seguridad de la ejecucién y la generacién del c6digo nativo a través
del compilador JIT (Just In Time, Justo a tiempo) encargado de traducir a cédigo nativo los componentes,
dependiendo de la CPU en la que se encuentren.

Bibliotecas base BCL (Base Class Library, Biblioteca de Clase Base): encargada de proporcionar los
componentes y clases necesarios para el desarrollo de aplicaciones en la plataforma. Estd compuesta por
Windows Forms, ASP.NET y Servicios Web XML y ADO.NET.

En cuanto a los lenguajes de desarrollo, estos siguen las especificaciones del estandar CLS (Common Language
Specification, Especificacién de Lenguaje Comun), por lo que son compatibles entre si, lo que hace que la eleccién del
lenguaje se ajuste mas al gusto del desarrollador que a motivos tecnolégicos.

Existe una gran variedad de lenguajes de programacion en la plataforma .NET, pero destacan dos de ellos:

VB.NET. Visual Basic .NET es la evolucién de Visual Basic 6.0, es el lenguaje natural para utilizar .NET pues
su sintaxis es igual que la de su predecesor, solo que con pequeiios cambios que le han permitido adaptarse a
la plataforma.

Ci#. Disenado especificamente para la plataforma .NET. Combina la complejidad de C y la flexibilidad de Java.
Su sintaxis resulta sencilla para los desarrolladores que estan familiarizados con ambos lenguajes.

Debido a que cada lenguaje utiliza su propia sintaxis de implementacién de las directivas del CLS, es necesario
que los compiladores traduzcan su cédigo fuente a un lenguaje entendible por el CLR. Ese lenguaje es el MSIL
(Microsoft Intermediate Language, Lenguaje Intermedio de Microsoft). De esta forma, los componentes y aplicaciones
resultantes de la compilacién reciben el nombre de assemblies o ensamblados. La naturaleza de estos archivos puede

6 Consultar bibliografia en la pagina web del libro.

7 Consultar bibliografia en la pagina web del libro.
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ser ejecutable (.exe) o bibliotecas de clases y componentes (.d/l). Los assemblies no son ejecutables directamente, sino
que se compilan al cédigo nativo de la CPU en la que se ejecuta el JIT del CLR, para ejecutarse en el dominio de la
aplicacién. Pero para que el CLR entienda cémo se deben ejecutar esas aplicaciones, los compiladores de los lenguajes
.NET incluyen los metadata o metadatos, los cuales proporcionan informacién sobre los objetos que conforman la
aplicacién o el componente que se halla generado.

[ —— Crca [Frovests,

Contiene

Contiene

Contiene

W Ajustado a E

R | Compilado porm
——{ R

Se ejecutan en

Prepara

Figura 1.9. Proceso de creacion y ejecucion de aplicaciones NET

La Figura 1.9 ilustra el proceso de creacién y ejecucion de aplicaciones con .NET.

Escribir la aplicacion “Hola Mundo” en el entorno de desarrollo de aplicaciones para Windows Phone es tan
sencillo como arrastrar un textblock hacia la zona del formulario central y hacer doble clic sobre el form. Asi se cargara
automaéaticamente el c6digo del formulario y se generara el método para el manejo del evento PhoneApplicationPage_
Load, que se ha de ejecutar una vez se cargue el formulario. En la seccién de este evento escribiremos el cédigo para
que aparezca el texto “Hola mundo” en el textblock que previamente arrastramos al formulario.

Using System.Windows.Media.Animation;
Using System. Windows.Shapes;

Using Microsoft.Phone.Controls;
Namespace HolaWP7

{

public parcial class Mainpage : PhoneApplicationPage

// Constructor
Public MainPage ()
{
InitializeComponent () ;
}
Private void PhoneApplicationPage Loaded (object
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sender, RoutedEventArgs e)

{
xtBlockl.Text = “Hola Mundo WP7”;

Finalmente, para compilar y ejecutar la aplicacion, basta con hacer clic sobre el botén Play o sobre la tecla F5.

ENTORNOS INTEGRADOS DE TRABAJO Y COMPILACION

Una vez presentados los lenguajes para programacién de aplicaciones méviles se pasard a presentar las
herramientas de desarrollo y compilacion para estos lenguajes.

Entorno para Blackberry

Para desarrollar aplicaciones Java para BlackBerry lo mas recomendable es utilizar un entorno de desarrollo
integrado. Se puede utilizar IDE generales como Eclipse y Netbean, configurando el entorno mediante el plugin
de BlackBerry, o bien utilizando un IDE especifico: BlackBerry proporciona JDE (BlackBerry Java Development
Enviroment). E1 JDE es un entorno de desarrollo integrado que permite desarrollar y simular aplicaciones Java
especialmente pensadas para teléfonos BlackBerry. Gracias a BlackBerry JDE, los desarrolladores pueden crear
aplicaciones con el lenguaje de programacién Java® ME y las API extendidas de Java para BlackBerry. E1 JDE esta
compuesto de los siguientes componentes:

BlackBerry Integrated Development Environment: el entorno integrado con capacidad de edicién de
codigo, gestion de proyectos, depuracion y traza de programas (Figura 1.10).

BlackBerry Smartphone Simulator: un simulador de teléfonos BlackBerry. BlackBerry Smartphone
Simulator ofrece un entorno tipo Windows completo y permite simular interfaces de usuario y la interaccién
del usuario, conexiones de red, servicios de correo electrénico y sincronizacién inalambrica de datos.

Java ME y API de BlackBerry: los paquetes de la especificacion de Micro Edition de Java y el paquete que
contiene la API especifica de BlackBerry para sacarle todo el partido a los dispositivos BlackBerry.

Aplicaciones de ejemplo: un conjunto de ejemplos de aplicaciones muy recomendables para iniciarse en el
desarrollo de esta tecnologia.

Ademas de lo anterior, el paquete JDE de BlackBerry incluye estas herramientas de soporte al desarrollo
adicionales. Algunas de ellas permiten desarrollar sin necesidad de un IDE ya que son para su ejecucion desde el
simbolo del sistema y otras son para integrar en IDE de terceros:

RAPC: es un compilador de linea de comando (a ejecutar desde el simbolo del sistema) para compilar archivos
Java y .jar en archivos .cod. Los ficheros .cod se ejecutan en BlackBerry Smartphone Simulator o en un
dispositivo BlackBerry.

Javal.oader: esta herramienta permite agregar o actualizar una aplicacién en un dispositivo BlackBerry. De
esta forma se pueden probar los archivos .cod de la aplicacién.
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BlackBerry Signature Tool: esta utilidad permite enviar solicitudes de firma de cédigo a BlackBerry Signing
Authority Tool.

Herramienta de verificacion previa: permite comprobar parcialmente las clases que se han desarrollado
antes de cargar la aplicacion en un dispositivo BlackBerry.

JDWP: facilita la depuracion de aplicaciones utilizando entornos de desarrollo integrados de terceros, como

Eclipse o Netbeen.
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Figura 1.10. El IDE de JDE de BlackBerry
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Figura 1.11. Eclipse con el plugin de BlackBerry
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La Figura 1.11 muestra el Eclipse con el plugin de BlackBerry.
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Entorno Para Android

El desarrollo de aplicaciones Android se realiza con un grupo de herramientas que son suministradas en el SDK.
La utilizacion de este grupo de herramientas puede ser de dos formas: utilizando un Entorno de Desarrollo Integrado
(IDE) en combinacién con un plugin llamado ADT (Android Development Tools, Herramientas de Desarrollo para
Android) o bien desde la linea de comandos. Se puede utilizar cualquier IDE, si bien lo méas comun es usar Eclipse.
Si se decide prescindir de un IDE se necesita inicamente un editor de texto para escribir el cédigo fuente e invocar
las herramientas de compilacién, depuracion, etc., desde la linea de comandos o mediante scripts. Algunas de las
herramientas mas importantes de linea de comandos son:

Android: crea y actualiza proyectos Android y crea y elimina AVD.
Android Emulator: gjecuta aplicaciones en una plataforma Android emulada.

Android Debu Bridge: es una interfaz para conectar la aplicaciéon con un emulador o con un mévil Android.
Permite instalar aplicaciones, ejecutar comandos en linea, etc.

Ant: permite compilar y construir proyectos generando el fichero .apk instalable de la aplicacion.

Keytool: permite generar una clave privada que se usa para firmar y autenticar el fichero .apk. Esta
herramienta forma parte del JDK.

Jarsigner: es una herramienta para firmar el fichero .apk con una clave privada generada con la herramienta
Keytool. Esta herramienta también forma parte del JDK.

La Figura 1.12 muestra los pasos béasicos para desarrollar aplicaciones Android. Estos pasos bdsicos estan
agrupados en cuatro etapas:

Instalacion: en esta etapa se instala el entorno de desarrollo completo incluyendo el EDI y el SDK de Android,
y se crean AVD (Android Virtual Device, Dispositivos Virtuales Android).

Desarrollo: en esta etapa se crea y desarrolla el proyecto Android, creando el codigo fuente de la aplicacion y
anadiendo todos los ficheros fuentes que pueda necesitar como imagenes o demas recursos.

Depuracion y pruebas: en esta etapa, en primer lugar se genera un paquete de depuracion .apk que contiene
el proyecto desarrollado en la etapa anterior. Este paquete se puede instalar y arrancar en cualquier emulador
o teléfono Android. Si se usa Eclipse, cada vez que se guarda el proyecto automaticamente se genera el .apk
correspondiente. A continuacién se depura la aplicacién usando un depurador JDWP y las herramientas debug
del SDK Android. Eclipse proporciona su propio depurador. Por iltimo, se comprueba el correcto funcionamiento
de la aplicacion usando varias herramientas del SDK como emuladores y herramientas de traza.

Publicacion: en esta dltima etapa se configura y se construye la aplicacién para generarse una version release
(una version de entrega) para distribuir entre los usuarios.

Como ya se ha comentado anteriormente se puede utilizar cualquier IDE para desarrollar con el SDK Android.
El méas extendido es Eclipse. Veamos con detalle como instalar y configurar Eclipse para desarrollar aplicaciones
Android.
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Instalar Eclipse

El entorno Eclipse se puede descargar desde el sitio web de descargas de Eclipse®. La version Eclipse IDE for Java
Developers es una buena opcion. La instalacién consiste en descomprimir el fichero .zip descargado. Esto crea una
carpeta llamada eclipse dentro de la cual hay, entre otros, el programa Eclipse, el cual inicia el entorno.

i | Instalacién de EDI | Instalar el entorno de desarrolio y |
i ) el SDK i
i Instalacién l i
[ Instalar los Dispositivos Virtuales [
I | AVD y dispositivos | Android (AVD) y conectar !
N dispositivos hardware b
T —— e 09090900 ‘:
. Desarrollo | Crear la aplicacion | Escribir el codigo fuente ;
{ | Construir aplicacién | Construir y ejecutar la aplicacion ‘i
; Depuracion i
i PR Depurar usando el depurador
| ypruebas | Depurar la aplicacion | o ;
i | Testear |a aplicacion | Testear con el emulador Android i
{ Configurar, construir y probar en Y
i Publicacién | Preparar para entrega | modo release i

Publicitar, vender y distribuir la
b | Distribuir |a aplicacion | aplicacion al usuario

Figura 1.12. Pasos bdsicos para desarrollar aplicaciones Android

Instalar el SDK Android

El paquete SDK se puede descargar en un fichero .zip o en una versiéon de instalador (solo para Windows). Si se
descarga un fichero .zip, la instalacién consiste inicamente en descomprimirlo (se descomprime automaticamente
en el directorio android-sdk-<machine-platform>, donde <machine-platform> es el nombre de la plataforma donde se
instala). Si se descarga la version de instalador para Windows tdnicamente se debe ejecutar el programa y seguir las
indicaciones del mismo.

Instalar el Plugin ADT para Eclipse
Para instalar el plugin ADT se deben realizar las siguientes acciones:

Iniciar Eclipse y seleccionar del ment Help la opcion de instalacién de nuevo software (menu Help > Install
New Software...).

Hacer clic en el boton Add... y aparecera un cuadro de didlogo en el que se solicita introducir el nombre del
repositorio donde esta el plugin (introducir ADT Plugin) y la URL de localizacién (introducir Attps:/ /dl-ssl.
google.com/android/eclipse/). La Figura 1.13 muestra este cuadro de dialogo.

8 http:/ /www.eclipse.org / downloads/
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10600 Install |

Available Software 1
Check the items that you wish to install. C = ||
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Figura 1.13. Ariadiendo el plugin ADT en Eclipse

El paso anterior origina que en el cuadro de didlogo aparezca una lista de software instalable de ese
repositorio. En concreto solo aparece un paquete. Se selecciona el unico que aparece haciendo clic en la
correspondiente check box (Developer Tools) y con el boton Next se pasa al siguiente cuadro de didlogo.

En la nueva ventana se muestra una lista de herramientas que van a ser descargadas. Hacer clic en el botén
Next y a continuacién aceptar los acuerdos de licencia. Por dltimo hacer clic en el botén Finish finalizando
el proceso de instalacién. Una vez que la instalacién ha sido completada es necesario restaurar Eclipse para
que la nueva instalacion tenga efecto.

Si ya se tiene instalado el plugin ADT conviene hacer actualizaciones cada cierto tiempo de las versiones mas
recientes. Para ello se utiliza el gestor de actualizaciones de Eclipse (Update Manger, accesible mediante el
mend Help > Check for updates).

Configurar el plugin ADT

En este paso se configuran algunas preferencias del plugin. En concreto se debe asociar el plugin con el SDK de
Android. Para ello seleccionar el menu Eclipse > Preferences y en el panel de la izquierda seleccionar Android.
A continuacion, en el panel principal se podr4 indicar mediante el botén Browse la localizacién del SDK que fue
descargado en su momento. Por tltimo, hacer clic en Apply y OK.

Aiiadir Componentes

E1 SDK de Android esta organizado en varias partes: versiones de plataformas Android, herramientas, ejemplos
y documentacién, las cuales se pueden instalar separadamente. El paquete SDK instalado que ha sido descargado
incluye solamente las herramientas. Para desarrollar una aplicacién Android necesitamos descargar e instalar la
plataforma Android. Este proceso se realiza mediante el gestor AVD (Android Virtual Device, Dispositivo Virtual
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Android). E1 AVD se puede ejecutar de varias formas. Una de ellas es desde Eclipse con el menti Window > Android
SDK Manager. Este mend proporciona la ventana del gestor de AVD y muestra todos los componentes del SDK que
se puede descargar e instalarse en el SDK local de la maquina en la que se trabaja. ;Qué componentes son los que
se deben descargar? Los componentes basicos son SDK Tools, SDK Platform Tools y SDK platform. La Figura 1.14
muestra el gestor AVD. Como se puede ver se muestran todos los paquetes asociados al SDK que se pueden descargar,
indicando cuadles estdn ya instalados.

800 Android SDK Manager

SDK Path: /Users/maximilianoparedes/android-sdks/

Pk e e

Name APl | Rev. Staws

J

O/ ¥ T Tools m

B % Android SDK Tools 16 Ehinstalled

=] % Android SDK Platform-taols 10 Sinstalled

® ¥ (& Android 4.0.3 (AP 15)

™ £ Documentation for Android SDK 15 1§ Notinstalled

) SDK Platform 15 2 Binstalled

™ & Samples for SDK 15 1§ Notinstalled

™ §' ARM EABI v7a System image 15 1 | § Notinstalied

™ 'R Google APIs by Google Inc. 15 1§ Notinstalled

] Sources for Android SDK 15 1§ Notinstalled

O » [ Android 4.0 (API 14)

O » (&l Android 3.2 (API 13)

O » [ Android 3.1 (API 12)

O ¥ (& Android 3.0 (API 11) v

O » (& Android 2.3.3 (AP 10)

O » (&l Android 2.2 (API 8)

O » [ Android 2.1 (API 7)

Show: (¥ Updates/New [ Installed [ Obsolete Select New or Updates install 5 packages... ) |

Sort by: (@ API level O Repository Deselect All Delete 1 package... .
|

mE!
Done loading packages. B P

Figura 1.14. AVD Manager

Con este tltimo paso ya queda configurado el entorno de desarrollo listo para programar a falta de crear dispositivos
emuladores (ver apartado 1.4.3).

Entorno para Symbian

Este sistema puede programarse con gran variedad de entornos de desarrollo dependiendo de la tecnologia de
programacion que queramos utilizar. Las principales tecnologias son Java Micro Edition y C++, para la primera es
necesario disponer del SDK para la serie sobre la que queramos programar y luego utilizarla junto con un entorno de
desarrollo como puede ser Eclipse o NetBeans, al ser J2ME una tecnologia muy extendida es posible construir gran
cantidad de aplicaciones sin los SDK, pero si queremos utilizar el cien por cien de la funcionalidad de los dispositivos
finalmente tendremos que utilizarlo. Si bien instalando, por ejemplo, NetBeans con soporte para J2ME podremos
crear aplicaciones que correrdn directamente en todos los dispositivos Symbian.

A pesar de la facilidad de desarrollo de aplicaciones J2ME, para desarrollar aplicaciones realmente potentes en la
plataforma Symbian hay que utilizar la tecnologia basada en C++, para ello tendremos que localizar el SDK para C++
de la serie para la que vamos a construir nuestra aplicacion. Para C++ existe un entorno basado en Eclipse y en el SDK
Qt llamado Carbide c++, desarrollado expresamente por Nokia para el desarrollo de aplicaciones de todas las series.
También existe un plugin para Visual Studio C++ de Carbide c++ con el que es posible desarrollar aplicaciones C++.

Una de las maneras maés sencillas de programar aplicaciones para la serie S60 seria utilizando PythonForSerie60
que directamente nos permite crear las aplicaciones dentro de nuestro propio teléfono en el lenguaje Python 2.5.
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Entorno para Palm OS (WebOs)

Para los antiguos entornos de desarrollo de Palm se requeria el SDK y los compiladores cruzados gce dentro de la
plataforma Linux o Cygwin que es Linux emulado en Windows.

Para el desarrollo de sistemas en webOS se utiliza el entorno Ares, que es el primer entorno de desarrollo para
moviles que funciona integramente dentro de un navegador. Para utilizarlo simplemente hay que registrarse en la web
http:/ / ares.palm.com y posteriormente introducir el usuario y clave con los que nos hemos registrado, no es necesario
instalar nada, desde cualquier ordenador que disponga de navegador y conexién a Internet se puede hacer uso del
entorno de desarrollo. La filosofia de este entorno al igual que la del sistema webOS es que el futuro de la tecnologia
moévil, y del resto de tecnologias se va a construir dentro de la web. De esta manera, resulta muy sencillo desarrollar
en la web, depurar en un dispositivo concreto conectado a la web y lanzar la aplicacién desarrollada en el catédlogo de
aplicaciones de webOS en la web.

Este entorno tiene dos vistas principales, una vista de gestion de ficheros, como se muestra en la Figura 1.15 y una
vista de diseno visual de pantallas y controles, tal y como muestra la Figura 1.16.

El sistema webOS también nos proporciona un SDK y un plugin PDk que permite desarrollar en C++ o en
JavaScript aplicaciones para méviles. Puede instalarse en cualquier plataforma Windows, Linux o iOS y se integra
dentro del IDE de Eclipse.

) Palm - Ares - Mozilla Firefox

Why web0S? . ipalm - ares x| fE]Home - He w |@Enyn Javase |Rlntmductmn I-"tutnna\ symbi...| - J2ME Tutorial... | \W/ Palm Pre - i |mnb\\e eric-p. |CCygwm |Hn > + -

cl(3-

samplad

neme  main

¥ B main

B rain-cl

-
% Drop local files

Figura 1.15. Entorno Ares en vista gestion de ficheros
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Entorno para Iphone

El desarrollo de aplicaciones para iPhone se realizé en un principio a través de paginas o proyectos web, sin
embargo, Apple vio la necesidad de controlar y unificar la programacién de las aplicaciones para sus diferentes
dispositivos. Es asi como en el afio 2008 decidi6 crear el SDK (Software Development Kit, Kit de Desarrollo de Software)
de Apple, un conjunto de herramientas y tecnologias de desarrollo para crear aplicaciones para iPhone e iPod Touch.

Para obtener el SDK es necesario inscribirse en el iOS Dev Center (el sitio oficial de desarrolladores de Apple)?,
desde donde se puede descargar gratuitamente. Si una vez creada la aplicacién se quiere comercializar, es necesario
enviarla al App Store, lo cual requiere registrarse en el programa de desarrolladores de Apple y pagar una cuota de
$99. El desarrollador fija el precio de la aplicacién y obtiene el 70% de las ventas realizadas a través del App Store.
Un dispositivo Apple solo ejecuta aplicaciones firmadas por Apple, por lo que después de asignado el permiso de
desarrollador, Apple expide un certificado que permite hacer pruebas en nuestro iPhone.

“) Palm - Ares - Mozilla Firefox

Archiva  Editar  Ver Hstorisl Marcadorss  Herramisntss  Avuds

< Ewhy web0s?...| {_iPalm- | (IPalm - Ares x [Hume'HPw. | ) Enyo Javasc... [glntmdumun..|-'|tutuna\ symbi...| - JZME Tutorial... | \W Palm Pre - Wi.. [mub\\e.er\:—p. |CCygwln

1 palm.com | https:jjares.palm. comfAresfindex. html v & | [ 2 Goode

Falette
UIWIDGETS
> Button Button ’ name

1 2010 Y

Header <HTML/>

main

Label

Feb

INFO

Integer Picker (varsion: 0.1)

NON-VISUAL PONENTS

Figura 1.16. Entorno Ares con vista de controles y disefio

9 i0S Dev Center: https:/ / developer.apple.com / devcenter/ios/index.action
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Hay dos aspectos clave a la hora de desarrollar una aplicacion: (i) las caracteristicas del dispositivo para el cual se
va a desarrollar la aplicacién (tamano de la pantalla, memoria, etc.) pues no es lo mismo programar para un iPhone
que para un Mac y (ii) el tipo de aplicacion, iOS permite tres tipos de aplicaciones:

Aplicacion web: se basa en contenido web, se ejecutan en un navegador y no hacen uso de las funcionalidades
del dispositivo.

Aplicacion nativa: este tipo de aplicacion utiliza las funcionalidades del dispositivo y se instala en el mismo,
de modo que para acceder a ella no hace falta conexién/acceso a Internet.

Aplicacion hibrida: es posible desarrollar aplicaciones combinando los dos tipos anteriores, de modo que
pueda instalarse en el dispositivo y ademaés requiera de un navegador para utilizarla.

Ademas de los tipos de aplicaciones, también podemos hablar del estilo, por ejemplo: (i) aplicaciones productivas,
en las que lo que prima es la utilidad que pueden ofrecer al usuario en la realizaciéon de una determinada tarea; (ii)
aplicaciones de utilidad, aportan informacién al usuario sin que tenga que realizar muchas acciones para obtenerla,
por ejemplo, una aplicacién que informe sobre el estado del tiempo; (iiz) aplicaciones de pantalla completa, tutiles sobre
todo en el soporte de juegos, musica y video.

Herramientas de desarrollo
El SDK incluye las herramientas necesarias para que la aplicacién pueda incluirse en el App Store.

Herramientas Xcode. Utilizadas para la codificacion, desarrollo y depuracion. Es un IDE (Integrated
Development Environmet, Entorno Integrado de Desarrollo) que permite escribir, compilar, ejecutar y depurar
el codigo de la aplicacion que se esta desarrollando. También es tutil para organizar los archivos por proyectos
y facilitar su importacién/exportacién (ver Figura 1.17).

066 P| MainProgram.pas - HiSimpleList

(=)
(@ Debug I CJ “ Debug ¥ :'] 51 '] W @ & b @ E:
Active Target Active Executable Action  Run  Debug Build Buildand Go 7 Info  Editor
Groups & Files I File Name 4 % [Code o A ©
& & | [F Info.plist i
| " Makefile [P MainProgram.pas m

3 Info.plist 5 Makefile
w[ Sources [ Rezr
P MainProgram.pas
¥[ Resources ;_

w[ ! Flat
[ Res
[ Rez.r
v (@ Targers
>@ Deploy
p@ Debug
¥ <4 Executables
<% Deploy
<4 Debug
» /B Errors and Warnings
¥ 2 Find Results
» (%] Bookmarks
P [§ SCM
@ Project Symbals
b [ Implementation Files
b [ NIB Files

Debug exited normally.

< | » | |p| MainProgram.pas:916
END;

PROCEDURE Closeal lWindows;

AR
theWlind: WindouRef ;
BEGIN
theWlind t= FrontWindou;
IF theliind o NIL THEN
RecursiveC lossWindou(theliing);
END;

FROCEDURE Termapplication;
BEGIN

Closshl Windous;
END;

C

>

@Succeeded

Figura 1.17. Herramientas Xcode
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También proporciona un simulador para probar la aplicacién antes de ejecutarla en el dispositivo. Es posible
desarrollar una aplicacién a partir de un patrén establecido, ya que Xcode proporciona una serie de plantillas

para tal fin.

Interfaz Builder. Permite disefiar la interfaz grafica de la aplicacién. Es basicamente una herramienta
grafica que trabaja en conjunto con Xcode. Desde la versién 4 de Xcode se puede programar el cédigo y diseniar
la interfaz de la aplicacién en la misma ventana, simplemente arrastrando y soltando elementos como controles
o componentes. Los archivos generados con Builder tienen extension .nib y describen la componente grafica
creada. El disefio se puede cargar mediante Cocoa Touch (ver Figura 1.18).

a0n “ Window ~|000 Attributes 000 Library
= * ‘ 4 ‘ & ‘ 1] Objects | Media
» [l Lbrary
Biblioteca
Inspector :
Pantalla

Empty selecction

B Bl a2 we
Botén —->‘__ ] Text !:‘ ? E

A Mathinggw.x_ih (=0

800

~ Round Rect Button '
—_— ‘ Ul Button Etiqueta

Implements a butten that intercepts touch events
and sends an action message to a target object
when it's tapped. You can set the title, image,
and other appearance properties of a button. In
addition, you can specify a different appearance
for each button state.

File's Owner  First Responder Random Gene...

Documento

Window

- ) (QFilter )

I
N

Figura 1.18. Herramienta Builder

Instruments. Esta herramienta permite analizar el comportamiento de la aplicacion mediante el anélisis
de parametros como: () memoria consumida por la aplicacién, (ii) ancho de banda consumido, (iii) recursos
utilizados y energia requerida, (iv) datos acerca de las animaciones o actividad relacionada con archivos y
sockets (ver Figura 1.19).
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Dentro de las herramientas de desarrollo también encontramos el emulador, pero nos referiremos a €l en otra
seccion dedicada a emuladores para iPhone.

53] e

ol File Activity $ ) File Activity

v CaliTree - F... FD|Path

] Separate by Thread 0 ~

O Invert Call Tree h €... 6 Jvar/folders/iY[iYFIbcB6Hg8YV7qjvFSvOE++ +Tl/-Caches-/com.apple.IntiDataCache.le.sbdl -

(¥ Hide Missing Symbols 2644 Open... o.. 5 /var/folders/iY/iYFIbcB6Hg8YV7qjvFSvOE+++Tl/-Caches-/com.apple.IntiDataCache.le L

) Hide System Libraries 2643 IntlFC... c... 5 /var/folders/iY/iYFIbcB6HgBYV7qjvFSVOE++ +Tl/-Caches-/com.apple.IntiDataCache.le

) Show Obj-C Only 2642 confst... s. Jvar/folders/iY JiYFIbcB6HgBYV7qjvFSVOE+++T1/ -

I Flatten Recursion 2641 IsMen... s Jvar/db/.AppleSetupDone b
i

b Call Traa Canctrainte

Figura 1.19. Herramienta Instruments
En resumen, los pasos para el desarrollo de aplicaciones para iPhone son los siguientes:
1 Inscribirse en el iOS Dev Center y descarga del SDK.
Registrarse como desarrollador de Apple (este paso es necesario solo para desarrolladores que quieran comercializar
la aplicacién desarrollada).
3 Elegir el tipo de aplicacién a desarrollar.
4Utilizar las herramientas de desarrollo para el disefio y puesta a punto de la aplicacion.

5 Probar la aplicacién, utilizando el simulador de i0OS y luego sobre el dispositivo de Apple.

6Distribuir la aplicacion a través del App Store (una vez obtenida la firma de Apple).
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Entorno para Windows Phone

Para desarrollar aplicaciones para teléfonos con S.O Windows Phone, lo primero que necesitamos es descargar
el SDK que se encuentra disponible en la web oficial del App HUB: http:/ / create.msdn.com/en-us/home/getting_
started y que contiene las siguientes herramientas:

Visual Studio 2010 para Windows Phone. Es una de las herramientas que utilizaremos en el proceso de
desarrollo de las aplicaciones. Esta version es gratuita y completamente funcional. Desde la ventana principal
podremos definir dos tipos de proyectos diferentes, Silverlight para Windows Phone 7.5 o0 XNA 4.0 para
Windows Phone 7.5, en ambos casos utilizando el lenguaje C#, seleccionando New Project o desde el menu
File > New > Project, tal como se muestra en la Figura 1.20.

| Buscar Plantillas instalad 2|

(BT Eenavoks_~Jasmmper[?
Plantillas instaladas

Tipo: Visual C#
(n. Aplicacién de Windows Phone 3 Visual C# I s
isual Cos o |

Proyecto para crear una aplicacién de
ATL ‘Windows Phone
CLR

General

,

Aplicacién de enlace de datos de Windows Phone Visual C#

MEC Biblioteca de clases de Windows Phone Visual C#
Prueha
Win32 Aplicacién de panorama de Windows Phone Visual C#
Dtros lengusjes =|
alEa 1 Aplicacién dindmica de Windows Phone Visual C#
Windows Aplicacion de Silverlight y XNA para Windows Visual CG#

Web

i Office
Cloud
Prueba el

Agente de reproduccién de audio de Windows Phone Visual C#

E Agente de transmisién por secuencias de audio de Windo... Visual C#
Reporting

i SharePoint 2

Silverlioht Agente de tareas programadas de Windows Phone Visual C#
Silverlight for Windows Phone

1 — i —]

Plantillas en linea 4

Mombre: || miprimera aplicacion 1

Ubicacion: cusers\ nombreuse\documentsivisual studio 2010\Prajects * Exarninar...

Nombre de la solucién: - miprimera aplicacion Crear directorio para la soluci

[] Agregar al control de cédigo fuinte

Figura 1.20. Creacién de un proyecto en Visual Studio 2010 (fuente: http:/ | www.carlosluengo.es/2011/11/)

Microsoft Expression Blend 4 para Windows Phone. Orientada al disefio de interfaces de usuario, esta
herramienta trabaja en clave con Visual Studio 2010. Como desarrolladores tendremos control sobre el aspecto
de la aplicacién, pudiendo definir animaciones, transiciones o personalizando las plantillas de control, los
estilos o plantillas de datos y también, podremos enlazar los datos visualmente. Los proyectos que tenemos
en Visual Studio 2010 son accesibles desde Expression Blend 4, por lo que es posible trabajar sobre un mismo
proyecto en los dos entornos. Asi por ejemplo, al abrir un archivo XAML, CS o VB podremos seleccionar, a través
del menu contextual, la opcién Edit in Visual Studio para editar el archivo seleccionado en Visual Studio y
después de realizar los cambios y guardar, podremos volver a Expression Blend 4 donde los cambios se cargaran
automaticamente (ver Figura 1.21).
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Nuevo proyecto
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Aceptar Cancelar

© RA-MA

Figura 1.21. Selecciéon de un proyecto en Expression Blend 4 (fuente: hitp:/ /www.dnmplus.net / articulos / notificaciones-en-silverlight.aspx)

Application Development Tool. Esta herramienta permite mostrar aplicaciones en formato XAP al
emulador o a un dispositivo desbloqueado para desarrollo, con lo cual, podremos probar aplicaciones fuera de
Visual Studio. Podemos hacer lo mismo desde Visual Studio, haciendo clic sobre el proyecto y seleccionando la
opcién Deploy (Desplegar), con lo cual se instalara la aplicacién en el dispositivo seleccionado en la barra de

herramientas (ver la Figura 1.22).

-
&F Applicaticn Deployment
¥

==

Phone.

click "Deploy”

Application Deployment

This tool allows you to install a prepackaged XAP on a registered Windows

Please select the device target for installation and the XAP to be installed, and

@ Windows Phone

Target: | Windows Phone 7 Device

KAP:

Status:

Browse

Figura 1.22. Herramienta de despliegue de aplicaciones
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Developer Registration Tool. Con esta herramienta podremos registrar un dispositivo fisico Windows Phone
con nuestra cuenta de desarrollador de Marketplace. De esta manera, el dispositivo quedara desbloqueado para
desarrollar, depurar y desplegar aplicaciones en él (ver Figura 1.23).

8§ Windors Phone Developer Regitration [==)

Developer Phone Registration @ Windows Phone

This tool allows you 1o register your Windows Phone for use in development
and debugging of Windows Phone applications. Before using this tool you
must have a current account on the developer portal. Please visit htp://
developer com for more Please enter the Windows.
Live ID you use with the Windows Phone Developer Portal

I Windows Live ID:
Password:
Status: Unable to cannect to phone. Please check

that the Zune software is running and that
Zune's syne partnership with your phone has
ished.

Figura 1.23. Herramienta de registro de dispositivos
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Figura 1.24. Marketplace Test Tool

Windows Phone Marketplace Test Tool. Esta herramienta permite realizar pruebas automaticas y
manuales de la aplicacién. Estd integrada en Visual Studio 2010, basta con hacer clic con el botén derecho
sobre el nombre del proyecto y escoger la opcién Open Market Test Kit (ver Figura 1.24).
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Las opciones de esta herramienta son:
Application Details: carga la iconografia y capturas que vamos a enviar al Marketplace.

Automated Test: ejecuta pruebas automaticas para comprobar el funcionamiento de la aplicacion. Es
necesario compilar la aplicacién en modo Realise.

Monitored Test: permite hacer pruebas teniendo en cuenta parametros especificos como tiempo de
arranque, consumo de memoria, etc.

Manual Test: proporciona una lista de comprobacion para realizar 50 pruebas de forma manual sobre la
aplicacién, marcando aquellas en las que la aplicacion ha fallado.

De esta forma nos aseguramos de que la aplicacién que vamos a mandar al Marketplace funciona correctamente.

EMULADORES

Los entornos de desarrollo presentados en el apartado 1.4.2, utilizan emuladores para la simulacién de las
aplicaciones que desarrollan sin necesidad de utilizar un dispositivo moévil real. Estos emuladores suelen ir integrados
en los entornos de desarrollo, si bien se pueden instalar y utilizar en algunos casos independientemente.

Emuladores para Android

El SDK Android incluye un emulador de dispositivos méviles virtuales. El emulador puede invocar a otras
aplicaciones, acceder a red, reproducir audio y video, almacenar y recuperar datos, etc., usando servicios de la
plataforma Android. Ademads, también proporciona servicios de depuracién y permite realizar prototipos de aplicaciones,
desarrollar y testear aplicaciones Android sin necesidad de un dispositivo fisico. El emulador proporciona una ventana
en la que se visualiza en ejecucion la aplicaciéon que se esta desarrollando junto con otras aplicaciones Android. El
emulador utiliza configuraciones AVD (Android Virtual Device, Dispositivo Virtual para Android). Un AVD permite
definir ciertas caracteristicas hardware del teléfono a emular. Se pueden crear varias configuraciones para diferentes
plataformas Android mediante los AVD.

Un AVD esté4 formado por:

Perfil hardware: define las caracteristicas hardware de dispositivos virtuales. Por ejemplo, se puede definir
si el dispositivo tiene camara, si usa teclado fisico QWERTY, cuanta memoria tiene, etc.

Mapping del sistema: se puede definir para qué version de la plataforma Android se ejecutara el emulador.

Otras opciones: especifica otras caracteristicas del emulador, como la dimensién de la pantalla, la apariencia,
si se quiere emular una tarjeta de almacenamiento SD, etc.

Area de almacenamiento: es necesario un espacio de almacenamiento de la maquina de desarrollo para
almacenar los datos del usuario del emulador (como aplicaciones que instala el usuario en el emulador) y la
tarjeta SD emulada.
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Lo mas comun es integrar y utilizar el emulador desde el EDI que se esté utilizando para desarrollar aplicaciones
Android. Eclipse proporciona con el mend Window > AVD Manager un gestor de dispositivos virtuales. Este gestor
muestra una lista de dispositivos virtuales que estdn instalados en el entorno de desarrollo y diferentes opciones para
gestionarlos (afiadir nuevos, editarlo, borrarlo, etc.) (ver Figura 1.25). Cuando se instala Eclipse y el SDK de Android,
no se crean automéaticamente los dispositivos virtuales. Esto se tiene que hacer explicitamente, mediante el botén
New, el cual muestra un cuadro de didlogo que permite configurar el emulador (ver Figura 1.26).

List of existing Android Virtual Devices located at /User imili edes/.android/avd
AVD Name Target Name Platform API Level CPU/ABI
- EmuladorAPI1S  Android 4.0.3 4.0.3 15 ARM (armeabi-v7a)
Edit...

Delete.
Repair
Details
Start...

“ Avalid Android Virtual Device. | A repairable Android Virtual Device.

X An Android Virtual Device that failed to load. Click 'Details’ to see the error. Y

Figura 1.25. Gestor de dispositivos virtuales

Name: | EmuladorAPi1s |
Target: [ Android 4.0.3 - API Level 15 ]
CPU/ABI: | ARM (armeabi-v7a)
SD Card
@ size: [ miB %
O File: ( Browse... )
Snapshot:
[ Enabled
Skin: ]
@ Built-in: [ Default (WVGABOD} =]
() Resolution: X
Hardware: pperty Value
Abstracted LCD density 240
Max VM application hea... |48 Delete
Device ram size 512

[_] Override the existing AVD with the same name

e ) )

Figura 1.26. Crear un nuevo emulador Android
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Para completar la instalacién y configuracion del entorno de desarrollo Eclipse es necesario crear un dispositivo
virtual. Como ya se ha comentado esto se realiza mediante el botén New del meni Window > AVD Manager. En el
nuevo cuadro de didlogo que aparece es necesario indicar un nombre y seleccionar el target (1a API de la plataforma
Android en la que se desarrolla) (ver Figura 1.26). Cuando se crea un dispositivo virtual o emulador el desarrollador
puede también configurar algunos aspectos béasicos de hardware (como LCD, tamafio de la maquina virtual en el
emulador, tamano de la RAM, etc.) y ademas puede anadir méds caracteristicas hardware al dispositivo virtual y
configurarlas mediante el botén New como son pantalla sensible al tacto, teclado, GPS, bateria, etc. Es importante
seleccionar el target apropiado ya que si se estd desarrollando una aplicacién con una cierta API, esta aplicacién no se
podra ejecutar en un dispositivo virtual que tenga un target con una versién de API inferior. La Figura 1.27 muestra
la ejecucion de un emulador.

Figura 1.27. Apariencia de un emulador Android (fuente: hitp:/ / developer.android.com / guide / developing / devices | emulator. html)

El emulador de la Figura 1.27 es el proporcionado por el SDK de Android. Sin embargo, hay otros emuladores
que se pueden descargar independientemente y ejecutarlos, instalando aplicaciones en los mismos. En estos casos las
capacidades de depuracién del emulador pueden mermar o ser inexistentes. Algunos de estos emuladores son Google
Android Emulator (ver Figura 1.28). En general este tipo de emuladores no tienen demasiada presencia en el mundo
de los desarrolladores.
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Figura 1.28. Emulador Google Android (fuente: hitp:/ | www.addictivetips.com / windows-tips / download-google-android-emulator/)

Emulador para Blackberry

Hay varios simuladores BlackBerry disponibles para emular la funcionalidad de varios productos como dispositivos
BlackBerry y BlackBerry Enterprise Server. Los simuladores BlackBerry Enterprise Server simulan ciertos servicios
(como MDS services y email) del servidor de BlackBerry (Enterprise Service), que pueden ser usados en combinacion
con un simulador de dispositivos BlackBerry (simular contenidos web). Dentro de los simuladores para dispositivos
BlackBerry se pueden encontrar dos principales emuladores: BlackBerry PlayBook Simulators, para desarrollos de
aplicaciones para dispositivos PalyBook, y BlackBerry Smartphone Simulators, para dispositivos méviles smartphone.
Estos simuladores permiten testear el software, pantallas, teclados, etc., con los que las aplicaciones que se desarrollan
trabajaran en dispositivos reales. Los simuladores también simulan el entorno de varias condiciones de redes wireless.
El BlackBerry Smarthpone Simulators puede ser descargado e instalado como un programa .exe en una maquina
Windows, si bien, y es lo mas comun, suele estar integrado en el JDE de BlackBerry, con lo cual al descargar el entorno
de desarrollo ya se estd descargando también el simulador. La Figura 1.29 muestra una ventana de un emulador
BlackBerry para smartphone.
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® lackncrry 5030 for U.5, Celular Similatar

B £l Yew Smistn ook e

Figura 1.29. Emulador BlackBerry (fuente: http:/ | techtastico.com / post | simulador-blackberry | blackberry-device-simulator/ )

Emulador para Symbian

Cada uno de los entornos de desarrollo suele llevar incorporado su propio emulador o utiliza los que proporcionan
los SDK de las diversas series de Symbian. Aunque algunos lenguajes como pyS60, que es Python para la serie
S60, no necesitan emulador ya que este lenguaje puede ser ejecutado en cualquier plataforma, y como comentamos
anteriormente puede programarse incluso directamente en el propio dispositivo, sin necesidad de realizar compilaciones
cruzadas.

Los emuladores permiten seleccionar las caracteristicas del modelo a emular, de esta forma podemos ver como se
adapta, sobre todo la interfaz grafica a las diversas resoluciones y tamanos de pantalla de los diferentes dispositivos.
A continuacién, en la Figura 1.30 se muestra un ejemplo de diversos modelos de dispositivos para emuladores en la
plataforma de desarrollo Netbeans para J2ME.

Figura 1.30. Diversos dispositivos emulados en J2ME
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Como podemos observar en el tamano de pantalla, vemos que en todos hay diferentes elementos graficos del mismo
juego, como la interaccién, pero el Gltimo emula un dispositivo téctil, son diferentes. De hecho una de las tareas mas
laboriosas del desarrollo de aplicaciones para méviles es verificar su correcto funcionamiento con el maximo nimero
posible de configuraciones de dispositivos méviles.

Emulador para Palm Os (WebOS)

Los antiguos emuladores para Palm eran monocromo, sin pantalla tactil y con muy baja resolucién, los proporcionaba
la empresa Palm como herramientas independientes y se disponia de una versiéon emulador y una version simulador.
La primera emulaba la aplicacién que queriamos depurar mientras que la segunda simulaba un dispositivo completo
con todas las aplicaciones nativas que llevaba instaladas.

La Figura 1.31 muestra el resultado de una emulacién para una Palm antigua.

Figura 1.31. Emulacioén en Palm antigua

Los emuladores actuales para la plataforma webOS van incluidos dentro del entorno de desarrollo SDK, permiten
emular diversas configuraciones y resoluciones de pantalla. Se pueden ejecutar desde el propio entorno de desarrollo
Ares pero es necesario tener instalado en local el SDK.

La Figura 1.32 muestra las cuatro configuraciones de pantalla posibles en el entorno webOS.

DATE | Feb 06 2012

Figura 1.32. Emulacién en webOS
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Emulador para IPhone

El emulador iOS permite comprobar el correcto funcionamiento de la aplicacién. Ofrece funcionalidades como:
(i) rotacién, cuando gira el dispositivo la aplicacién rota con él; (ii) cambio de dispositivo, permite comprobar el
funcionamiento de la aplicacién tanto en un iPhone como en un iPad; (iii) comprobar el funcionamiento de la aplicacién
para diferentes versiones del iOS; (iv) avisos de memoria, permite comprobar el funcionamiento de la aplicacion
dependiendo del consumo de recursos (ver Figura 1.33).

ane P MsinProgram.pas - HiSimleList =)
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@odes ) [*Ddes

Acve Targe At Dpcuatle  Aton Bun Debeg B BuldandCo W Eaar

Figura 1.33. Simulador en modo iPhone e iPad

Windows Phone

El kit de desarrollo de Windows Phone incluye un emulador que nos permitirda simular las aplicaciones en
condiciones similares a las que encontraremos al ejecutarlas en nuestro dispositivo.

El emulador se ejecuta desde Inicio > Programas > Windows Phone Developers Tools > Emulador de
Windows Phone. También lo podemos lanzar desde Visual Studio 2010. El emulador nos permitira también probar
aplicaciones que utilicen sensores (acelerémetro) o que dependan de la localizacion (ver las Figuras 1.34 y 1.35).
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Figura 1.34. Emulador de GPS
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Accelerometer.

-31.8° 17.7°

Figura 1.35. Emulador del comportamiento de un acelerémetro (fuente: hitp:/ / blogs.microsoft.co.il / blogs / shair/archive/2012/01/28/ accelerometer-
sensor-for-windows-phone-7.aspx)

ARQUITECTURA J2ME

Como ya se ha comentado en los apartados anteriores, J2ME o Java 2 Micro Edition es la versién Java para
dispositivos méviles y sistemas de pequenio tamarnio. J2ME pertenece a la versién 2 de Java que est4 compuesta por
tres ediciones distintas:

Edicion Estandar (J2SE): este es el entorno basico de Java, esta compuesto por las clases basicas de Java,
que nos permiten desarrollar y ejecutar aplicaciones cliente, servidor y applets.

Edicion Empresarial (J2EE): es una ampliacién de la edicién anterior y estd pensada para el desarrollo de
aplicaciones servidor.

Edicion Micro (J2ME): es una version reducida de Java que permite desarrollar aplicaciones para sistemas
moéviles, empotrados y electrénicos de caracteristicas especiales. Las aplicaciones en esta edicién se denominan
MIDlets por analogia con los applets.
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La Figura 1.36 muestra la relacion entre las tres ediciones de Java 2.
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Figura 1.36. Entorno Java 2
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Configuracion: contiene la maquina virtual, normalmente es una version reducida de la maquina normal de

Java, junto con algunas librerias basicas. A la maquina virtual de la configuracion se la suele llamar KVM, ya

que requiere unos pocos Kilobytes para ejecutar el bytecode.

Perfil: esta desarrollado sobre una configuracién y proporciona un conjunto de librerias tutiles para poder

desarrollar aplicaciones completas con ellas.

Paquetes opcionales: son paquetes especiales que no pueden ser ejecutados en todos los dispositivos que
permiten obtener un acceso a todas las funcionalidades que nos aportan los dispositivos, por ejemplo, un
paquete opcional es la API para acceso al médulo GPS, otro paquete opcional es una API para programacién

con graficos 3D. No todos los dispositivos permiten utilizar GPS o graficos 3D.

Profile

&g MIDP, Foundation Prafifs

>
Configuration

e.g. CLDC, €DC
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Figura 1.37. Partes de J2ME
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CONFIGURACIONES Y PERFILES

Podemos ver en la Figura 1.37 que Java presenta dos configuraciones CLDC y CDC. La primera es la utilizada en
dispositivos moéviles mientras que la segunda esta pensada para dispositivos con méas recursos como PDA o tablets.
Dentro de estas configuraciones existen versiones.

Los dispositivos donde se ejecuten las aplicaciones con configuraciéon CLDC deben cumplir las siguientes
restricciones:

Disponer de entre 128 KB y 512 KB de memoria ROM o flash donde se almacena la propia maquina virtual y
de 32 KB de memoria volatil para guardar informacién en tiempo de ejecucion.

Procesador de 16 6 32 bits con al menos 25 MHz de velocidad.
Bajo consumo, debido a que suelen estar alimentados por bateria.

Tener algun tipo de conectividad como Wi-Fi, 3G, etc.

Sobre las configuraciones se definen perfiles, en el caso de la configuracion CLDC, se definen los perfiles para
dispositivos de informacion moévil o MIDP. Estan definidos sobre las siguientes restricciones minimas:

Pantalla de tamaio 96 x 54, con un solo bit de color y una forma de pixel cuadrada.
Entrada por teclado o pantalla tactil.

Memoria, 256 KB para el CLDC, 8 KB para guardar datos y 128 KB de memoria volatil para la ejecucion de
la aplicacién.
Sonido, para reproducir tonos musicales.

Conectividad, bidireccional e inalambrica, con un ancho de banda limitado.

Los perfiles MIDP nos permiten definir el ciclo de vida de los MIDlets, construir interfaces de usuario, soporte para
la red, juegos, sonido, criptografia, etc.

MODELO DE ESTADOS

Los MIDlets se ejecutan dentro de un entorno proporcionado por el Gestor de Aplicaciones o0 AMS (Application
Management Software), este es un programa que ademéds de guardar las aplicaciones desarrolladas para J2ME
contiene la implementacién de la KVM, CLDC y el MIDP. Todos los dispositivos que permiten J2ME tienen un Gestor
de Aplicaciones, que suele venir como una aplicaciéon independiente.

El Gestor de Aplicaciones no puede ejecutar los MDlet directamente, estos deben venir empaquetados en archivos
Jar que contienen uno o varios MIDlets asi como un archivo .jad que describe cada uno de ellos, indicando nombre,
recursos que necesita, fabricante, fecha de creacién, etc.

E1 AMS define el ciclo de vida de los MIDlets, que pasa por 5 fases: localizacién, instalacion, ejecucion, actualizacion
y borrado.

E1 MIDP define los tres estados en los que se puede encontrar un MIDlet cuando esta en ejecucion: Activo, Pausa
y Destruido.
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CICLO DE VIDA DE UNA APLICACION

A continuacién vamos a mostrar paso a paso el desarrollo de la primera aplicacién para méviles en el entorno
J2ME con el IDE NetBeans 7.1.

Vamos a la opcion de menu File > New Project y seleccionamos Java ME como muestra la Figura 1.38.

T GameBuilderDemo1 - MetBeans IDE 7.1

File Edit WView Navigate Source Refactor Run Debug Profile Team Tools Window Help

P D (O s ¥ T % DB

Projects x| Files | Services | 2| .20 [4® SPDemojava x| [ GameMidlet.java x | &% GameDesign java x | 2 HelloMIDiet.java x| (4] *][=] (0] [ palette x| o
[ B GameBuiderbemol e . s = Displayables |
= ProyectoHolaMunde /A, Alert Form
;. =-[@ Source Packages ; T 1B uist [L] Text Box
S-E8 helo = : R
. £ Mobile Device B <3 Logi =
: L [5#HelloMIDlet. java 5] ] Login Screen Splash Screen =
| G resowces e e I T D D 8 e s [F Watt Scrzen e
i i £ g i s P S R L e
. Wl ProedCofigraions 0 EE— ) e PIM Browsar [ sMs Composer
& B sPbemot Resumed | & s B
— Al Back Command Cancel Command
T New Project A
7 Exit Command A Help Command
e NS ERE ek 7] Ttem Command %1 Ok Command
1. Choose Project Categories: Projects: 7 Screen Command &4 Stop Command
25 Ve D) 1ava B Mobile Application = Elements
-2 Javarx E| Mabil Class Library || Choice Element Lisk Elemenk
O Javaweb [l Mobile Project with Existing MIDP Sources
|- Items
o= El tmport Wireless Toolkit Project
By B coc appiication || Choice Group Date Fizld v
-3 Javacard
E coc Class Library ilderDemol - Properties x =
| [El tmport €DC Pack 5.5 Project
) Maven El mport COC Tookt Project
= PHP & Mobilz Designer Companents
-2 Groovy
A0 crcr+
L) NetBeans Modules PRk
GameBuilderDemol - Navigator x £ samples
Description:
Creates a new MIDP application in a standard IDE project. You can also generate 3 MIDlet in the
project. This project uses an IDE-generated Ant build script and special tasks to preprocess,
build, obfuscate, preverify, run, debug, and deploy your application in the Java ME environment.
LameBuilderDemo1 a
< Back L Next > J Finish [ Cancel J [ Help ]
<No View Available > Tasks XI =
e <no tasks >
<no tasks> (in all opened projects)

Figura 1.38. Eleccién de proyecto Java ME

Hacemos clic sobre el botén Next y a continuacién nos sale la siguiente ventana de didlogo donde vamos a indicarle
el nombre del proyecto en el campo de texto Project Name, ahi pondremos ProyectoHolaMundo y haremos clic en
el bot6n Next de esta ventana de didlogo.
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La siguiente ventana llamada Default Platform Selection la dejamos tal cual, y hacemos clic en el botén Next
de nuevo. Pasamos a la pantalla More Configuration Selection, donde tampoco cambiamos nada y hacemos clic en
el botén Finish. A partir de este momento el entorno creara un proyecto funcional pero vacio y con nuestra aplicaciéon
como aplicacién principal, como muestra la Figura 1.39.

® GameBuilderDemo1 - NetBeans IDE 7.1

Eile Edt View Navigate Source Refactor Run Debug Profile Team Tools Window Help
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EX=] Souce  Saeen | Flow | Anavzer | 8 5 E Displayables a
[ ProyectoHolaMundo A Alert Form
=@ Source Packages ! i 4 1 List [I] Text Box
-8 hello B ; ; e L
Mobile Device B IE: =
3 MEHEIIuMID\Et.]ava . ] Login Screen Splash Sereen
Resources MiDlet ] E Wait Screen File Browser
. . Started ]
@ Project Configurations 1 @ PIM Browser % SMS Composer
StPDemot i || = Commands
|| £ Back Command 0 Cancel Command
|| Z Exit Command 5 Help Command
EE : || & 1tem Command Z Ok Command
i B || &4 sereen Command &4 stop Command
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............................................. EiEe a
1l & Demol - Properties x =l
............................................. <Ma Properties>
GameBuilderDemo1 - Navigator = =l
| ‘GameBuilderDemo1 9
Tasks x I =
T <no tasks>
<no tasks> (in all opened projects)

Figura 1.39. Entorno Java ME vista flujos

% 1t |

Nos aparece seleccionado el editor de flujos de ejecucion con la etiqueta Flow resaltada (véase la Figura 1.39). Este

editor no lo vamos a utilizar en este ejemplo. Vamos a pulsar sobre la etiqueta Sereen y nos aparecera un editor que
nos permite cambiar elementos visuales del dispositivo, vamos a cambiar el texto Hello por Hola y Helo World! por
Hola Mundo. Para ello nos vamos a los campos Label y Text del didlogo de propiedades que es el que hay abajo a la
derecha llamado Properties. En la Figura 1.40 donde ya han sido realizadas las sustituciones.
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Figura 1.40. Entorno Java ME vista diserio

Ahora solo falta ejecutar nuestro primer proyecto, para ello solo hay que pulsar la tecla F6 o ir a la opcién de mend
Run > Run Main Project o hacer clic en el icono verde de Play que hay en la barra de herramientas en el centro
superior de la pantalla. En cualquiera de estos casos comenzara a ejecutarse el emulador y nos mostrara nuestra
primera aplicacién para méviles. Todo ello sin teclear una sola linea de cédigo Java (ver Figura 1.41).
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Figura 1.41. Ejecucién del proyecto

Por tultimo, si dispone de un teléfono mévil con gestor de aplicaciones para J2ME puede pulsar sobre el proyecto
con el botén de la derecha del ratén, seleccionar la opcién Batch Delploy... y se generara un archivo llamado
ProyectoHolaMundo.jar que puede enviar a su mévil y se instalard automéaticamente con el gestor de aplicacién y
podré ejecutarlo cuando desee.
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I ACTIVIDADES 1.1

Suponga que esta instalado el plugin ADT en un entorno Eclipse. ¢Como se puede actualizar la Ultima versién
de este plugin desde Eclipse? Indique el camino de menu a realizar.

Si se tiene la instalaciéon por defecto del SDK de Android bajo Eclipse y se quisiere descargar e instalar el
componente Documentation for Android SDK de dicho paquete, ¢qué utilidad se debe usar? Indique el camino de
menu de Eclipse para arrancar dicha utilidad.

Realice una revisidn de las caracteristicas de los ultimos modelos de teléfonos méviles con S.0 Android, iPhone
y Windows Phone. éQué funcionalidad afadiria en cada caso, distinta a las ya existentes?

RESUMEN DEL CAPITULO

En este capitulo se ha proporcionado una visién de los principales hitos que han enmarcado la historia y
evolucion de los dispositivos méviles. También se ha presentado un resumen de las principales limitaciones
a las que se enfrentan los desarrolladores, asi como también los beneficios e inconvenientes de los
principales enfoques que puede utilizar, segtin las necesidades de la aplicacion a desarrollar. Adema4s,
se han descrito las tecnologias disponibles en la actualidad, los lenguajes de desarrollo, los entornos
especificos y las caracteristicas de los sistemas de simulacién asociados a cada tecnologia. Finalmente se
ha descrito la arquitectura J2ME y sus principales componentes.
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EJERCICIOS PROPUESTOS

1. Descargar desde http://www.eclipse.org/
downloads/ y realizar la instalacién de Eclipse IDE
for Java Developers en el disco duro del ordenador.

2. Instalacion del SDK Android. Se quiere instalar
el paquete SDK de Android desde el formato
comprimido .zip, para ello se debe conectar a http://
developer.android.com/sdk/index.html y realizar
la instalacién por defecto en el disco duro de la
maquina.

3. Se desea instalar la ultima version del plugin ADT
para Eclipse desde el propio IDE Eclipse. EIl nombre
que se quiere dar al repositorio que se afiade es “ADT
Plugin”.

4. Cree un dispositivo virtual Android con AVD
Manager con las siguientes caracteristicas para un
target Android 4.0.3: 2 GB de tarjeta SD Card y un
tamano de RAM de 1.024 MB.

5. Descargue e instale Java Development Enviroment
de BlackBerry en el disco duro del PC.

6. Descargue el SDK de Windows Phone y cree la
aplicacién “Hola Mundo”. Verifique su ejecucién
utilizando el emulador.

7. Descargue el SDK de iPhone y cree la aplicacién
“Hola Mundo”. Verifique su ejecucion, utilizando el
emulador.

TEST DE CONOCIMIENTOS

;Qué es la Computacién Ubicua y cudles son sus
pilares fundamentales?
Descentralizacion, diversificacién, conectividad
y simplicidad.
Rapidez, sencillez y disponibilidad.
Descentralizacion, diversificacion y rapidez.
Las respuestas b y ¢ son correctas.

;Cudl es el cambio més relevante en las baterias de
los teléfonos moviles?
Livianas, sin materiales téxicos, control de la
temperatura.
Mayor duracién, menor tiempo de carga.
Mas econémicas.
Las respuestas a y ¢ son correctas.

(Cuadles son las limitaciones para el desarrollo de
aplicaciones en teléfonos méviles?

Latencia.

Deficiencia en las conexiones.

Tamario de las pantallas.

Las respuestas anteriores son correctas.

(Cudles son los enfoques principales para el
desarrollo de aplicaciones para dispositivos méviles?
Clientes nativos, clientes JME.
Clientes basados en la web, clientes basados en
Midleware.
Clientes nativos, clientes JME, clientes basados
en la web y clientes basados en Midleware.
Clientes nativos y clientes Midleware.
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;Cudles son los principales componentes del modelo
software de Windows Phone?
Ejecuciéon, modelo aplicaciéon, modelo IU, Kernel,
hardware.
Ejecucién, modelo aplicacién, modelo IU,
integraciéon nube, Kernel, hardware.
Modelo aplicacién, modelo IU, integracién nube.
Ejecucién, modelo IU, hardware.

;Cuales son los componentes de la arquitectura del
sistema operativo i0S?
Cocoa Touch, Core Services.
Cocoa Touch, Media, Core Services, Core OS.
Media, Core Services, Core OS.
Applications, Applications framework, Libraries,
Kernel.

;Cudl es la principal caracteristica del lenguaje
Objective-C?

Su facilidad de uso.

Sus numerosas librerias.

Su parte dindmica.

Su facilidad para integrarse con otros lenguajes.

¢Por qué es necesario que los compiladores en .NET
traduzcan su cédigo fuente a uno entendible por el
CLR y como se llama ese lenguaje?
Porque se ejecutan en la CPU del dispositivo.
Porque necesitan generar informacién sobre la
aplicacidn.
Porque cada lenguaje utiliza su propia sintaxis
de implementacion de las directivas CLS.
Porque hace mads rdpida la ejecucién de la
aplicacidn.

¢ Qué funcion realizan los assemblies?
Proporcionan informacién sobre los componentes
de la aplicacion.
Compilan al cédigo nativo de la CPU en la que
se ejecuta el JIT del CLR para ejecutarse en el
dominio de la aplicacién.
Definen las directivas de implementacién de los
lenguajes.
Las respuestas a y ¢ son correctas.
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(De dénde se obtiene la informacién de los objetos
que conforman una aplicacién desarrollada en

la plataforma .NET?

De los assemblies.
Del JIT.

Del CLR.

De los metadata.

({Qué es un AVD de Android?
Un gestor de plugins Android.
Un dispositivo real Android conectado por USB.
Un dispositivo virtual Android.
El paquete de instalacién del SDK Android.

(Cuadl es la principal ventaja de BlackBerry?
El sistema operativo es cédigo abierto y esto
permite que haya muchas aplicaciones.
El sistema de gestiéon de memoria.
Hay muy pocos modelos en el mercado y esto
hace que sea muy simple manejarlo.
Su capacidad para enviar y recibir correos
electronicos por Internet.

Senale la afirmacién correcta sobre el sistema
operativo Android:
La maquina virtual de Android (Dalvik Virtual
Machine) forma parte del Entorno de Ejecucién.
La capa de Aplicaciones proporciona un conjunto
de servicios y sistemas para el desarrollador.
La capa de Librerias proporciona un conjunto de
aplicaciones de usuario como correo electroénico,
calendario y mapas.
La maquina virtual de Android (Dalvik Virtual
Machine) puede ejecutar cualquier cédigo Java
directamente.



